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SPATIAL AWARENESS

NOPE, YOUR EYES aren’t deceiving you
— Apple’s new spatial computer, Vision
Pro, is once again on the front cover of
Mac|Life. Is it overkill? Maybe, but I’'m
so excited by last issue’s “Vision of the
future”, and I think it’s going to be that
much of a gamechanger in the coming
years, that we’re covering it again. This
time round, we’re looking at spatial
computing as a whole: where it all
started (a long time ago, as it happens),
what it’s looking like now, and how
Apple’s groundbreaking headset is
going to move things forward.

Understandably, spatial computing
isn’t for everyone yet (whether they can
afford it, or not), so we’ve got plenty of other material this issue
which should help you to get the most out of the hardware that
you actually have access to at present. The first of these is a
feature that I’ve been wanting to cover for some time now, and
that’s how to upgrade an older Mac (pZ8), whether it’s finding
which modern apps still work with these more mature machines,
upgrading the hardware inside (which to be fair is a lot easier to
do than it is now), and we’re even going to show you how to
install macOS Ventura on an outdated Mac that was never
intended to run it. Major caveat: this is a cool thing to do, but
your Mac also might not like it, so don’t try this at home if you
rely on it for doing things day to day.

A somewhat more practical proposition for those with more
recent Macs is a complete guide to backing up your system with
Time Machine (p5d). I’m sure plenty of you have already carried
out this most essential of tasks, but if not, or you just want to
start afresh, then I highly suggest you have a thorough read.

For what it’s worth, the bean counters tell me that early
reports suggest that Mac/Life in its digital-only incarnation is
working out well, so long may the magazine continue. I’m still
getting a number of emails from people asking me why they can’t
access their digital subscription. While I am happy to help those
who get in touch, in some instances it would be easier to speak to
our dedicated subscription team (contact details on[p79). ®

W1

NICK ODANTZIS, Editor

Twitter: @maclife

FACEBOOK:[facebook.com/maclite
TWITTER:[fwitter.com/maclitd

EMAIL:[[etters@maclife.com]
SHARE YOUR THOUGHTS

Editor's opinion

© THE TEAM

Andrew Cottle

Art Editor

Andy has some old MacBooks,
and thinks it's great that they
still have potential — solving
some of the issues he thought
had written them off.

Rachel Terzian

Production Editor

Motion sickness is Rachel's
biggest reason for not faring
well with VR headsets, but will
Apple’s Vision Pro solve this
problem? She certainly hopes!

lan Osborne

Contributor

lan is worried that Vision Pro
won't be very spectacle-
friendly, and hopes a future
version will make it possible to
wear glasses in use.
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New Podcasts updates

Improved search, subcategories, and more to come

BY ALEX SUMMERSBY

APPLE’S PODCASTS APP has been
updated with new search features,
including subcategory charts and
language-specific recommendations.

Apple has added nine subcategories
in the Search tab across devices:
Books, Mental Health, Relationships,
Self-Improvement, Entrepreneurship,
Personal Journals, Documentary,
Parenting, and Language Learning.

Each subcategory has its own
charts, with the 200 Top Shows and
200 Top Episodes available in your
market, based on a mix of listening,
follows, and completion rate.

All 19 categories and these nine
subcategories have new artwork and
recommendations, including Apple
Podcasts Essentials — all-time
favorite podcasts for each category
curated by Apple’s global editorial
teams. Select categories will also
regularly showcase New & Noteworthy
shows, standout Shows of the Month,
Featured Channels and Creators, and
Global Highlights with popular shows
from around the world.

Listeners in the US, UK, Canada,
and Australia can now also find
recommendations through Podcasts
by Language, which supports more
than 20 languages in total but a select
range in each region. For example, a
US listener can explore podcasts in
Arabic, Chinese, French, and Spanish
while a UK listener gets Dutch, Italian,
and Portuguese. Select markets will
feature an additional “Podcasts in
English” destination.

Listeners can find all categories,
subcategories, and Podcasts by
Language from the Search tab on
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€ Search

Comedy

Their dynamic conversations have
cultivated a rabid following.

iPhone, iPad, Mac, and Apple TV, and
browse the charts for a category or
subcategory from the category page.
A selection of charts for top categories
are also accessible from Top Charts.

ALSO COMING TO PODCASTS
Apple has also previewed new features
coming to Podcasts this fall:

> A refreshed Now Playing design
features a sleek, dynamic background
that showcases a podcast’s art and has
enhanced controls for managing the
queue. Support for episode art enables

9:41

¢ Search Comedy

New & Noteworthy

Comedy Interviews Comedy

More in Comedy

| o

Essentials

L A..‘
Stolen Youth

listeners to explore more about an
episode. A new design for episodes,
shows, and channels in Up Next
makes it easier to preview, play, or
follow podcasts.

> Subscribers will be able to stream
the entire catalog of Apple Music radio
shows ad-free on Podcasts, and follow
individual shows to automatically
download and be notified of new
episodes as soon as they’re released.

> Apple News+ subscribers will be able
to listen to stories from top magazines
and newspapers on Apple Podcasts.

> Listeners will also have the ability to
access new shows and other benefits
by connecting eligible subscriptions to
top apps on the App Store, including
Bloomberg, The Times, The Washington
Post, The Wall Street Journal, and others.



> EU law forces change
After USB-C charging, it's removable batteries

EUROPEAN LAWMAKERS HAVE set
tough new rules that could mean future
iPhones and iPads will be required to
have removable batteries.

This comes after the EU imposed
laws requiring devices sold in Europe
after 2024 to use USB-C for charging,
meaning all future iPhone models will
lose the Lightning port for USB-C.

The new rules cover the design,
production, and waste management
of all types of batteries sold in the EU.
They include stricter waste collection
targets, minimum levels of materials
recovered, and minimum levels of
recycled content in new batteries.

To help make recycling easier, Europe
will require “portable batteries in
appliances” to be designed “in such

a way that consumers can themselves
easily remove and replace them.”

Apple is slowly expanding its Self
Service Repair program, which has

included iPhones from the start, but
the program is aimed at users with
experience of repairing electronic
devices, not ordinary consumers. It is
unclear whether Europe will be satisfied
with anything less than pop-out
swappable batteries.

Separately, Apple software VP
Craig Federighi confirmed that Apple
is "working with the EU" to comply with
a new law taking effect in March 2024
that requires iOS users to have access
to third-party sources of apps outside
of the App Store. Bloomberg reports
that there would still be security
requirements, similar to those in
macOS, and the option would be
available only in countries where it
is required by law, with the system
verifying the user's location first.

This could soon extend to Japan,
where lawmakers are proposing new
“digital market competition” rules.

> Laptops dominate

IN THE 12 months ended March 2023,
on its own figures, Apple shipped about
$33.8bn worth of Macs. However, the
company does not disclose sales by
model. The latest report by market
research firm Consumer Intelligence
Research Partners (CIRP) claims that in
this period, “laptops accounted for over
three-quarters of Mac computer sales.”

On CIRP's figures, the laptop lines’
share increased by 3% from 74% last fall
to 77%. with the MacBook Pro line at
43% and MacBook Air at 34%.

This doesn’'t seem to square with the
claim in the WWDC keynote by Apple’s
VP of Hardware Engineering, John
Ternus, that the 13-inch MacBook Air
with M2 chip is “the world's best selling
laptop” — but he might have meant
it's the best selling single model, not

Image rights: LG Electronics.

product family. Or, some say, CIRP’s
survey might be skewed towards the
US, rather than the big picture.

It's also surprising to see shipments
of Mac Pro so high relative to the mass-
market Mac mini and Mac Studio, and
nearly level with iMac, especially
considering that until WWDC, the Mac
Pro had not been updated since 2019.

CIRP's figures might make sense if
they're based on dollar value and not
unit shipments — one high-priced Mac

Pro offsets a lot of affordable Mac minis.

Mac Studio
1%
Mac mini ™
MacBook Pro
3% 46 ol
43%
Mac Pro

9%

iMac
10% MacBook Air
34%

The latest news from the world of Apple

News in
brief

A bite of the Apple

> HI-FI FROM SPOTIFY

Spotify is reportedly ready to roll out a
more expensive subscription tier that
offers "high-fidelity” music. Spotify
announced it was working on a “HiFi”
feature in 2021 but delayed its rollout
when Apple Music and Amazon Music
both began offering high-quality tracks
as standard. Apple Music also offers
Spatial Audio, which is not available
from Spotify, but some users prefer
the Spotify interface and experience.
Bloomberg reports that the new tier will
launch this year, but outside the US first.

>AIRPLAY IN HOTELS WITH LG

At WWDC in June, Apple announced
that AirPlay support will be available in
selected hotels “before the end of the
year,” enabling you to use a QR code to
connect and play your own content or
mirror your Apple device. The idea is
that you aren't limited to what the hotel
offers and can take advantage of a big
screen, whether to enjoy a favorite show
via a personal Apple TV+ subscription or
prepare a presentation. LG Electronics,
which describes itself as the leading
provider of in-room hotel TVs, has
announced that its latest Smart Hotel
TVs will be the first to roll out the new
feature. Watch for hotels advertising the
service in the near future.
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> THE SHIFT

MATT BOLTON thinks EyeSight is the
smartest part of a very smart new headset,
but it will be made fun of

HE APPLE VISION Pro headset

is absolutely crammed with

clever tech. In classic Apple

style, very little of it is brand
new tech we haven’t seen before
on some prototype or niche
headset that was dead on arrival,
but Apple has been able to bring it
all together into something that
feels complete.

There is one thing I haven’t seen
before, though: EyeSight. This is
the screen on the outside of the
Vision Pro that basically shows
a recreation of your eyes inside
the headset. It is weird, it is kind of
dystopian in its general vibe, and
it’s also a brilliant solution to a
genuine problem.

EYESIGHT IS AN
AFFORDANCE THAT
MIXES SOFTWARE
AND PHYSICAL CUES

Long-time readers may
remember that I’ve written here
before about “affordances.” In
software, these are elements that
let people know that something
can be interacted with. A mouse
pointer that turns into a pointing
finger over a link is an affordance.
The insertion point that flashes
in text so you can see it is an
affordance. A scrolling list that
bounces when you reach
the bottom so you know you’ve
hit the end is an affordance.

These can come into real life too
— I believe that the stick design of
the AirPods is a valuable affordance
because it makes them more
visible, so people are more likely to
realize that you can’t hear them,
stopping them from becoming
embarrassed in the event of
attempting to talk to you.

EyeSight is an affordance that
mixes software and physical cues.
The wags will point out that it
creates a kind of uncanny valley
situation, making it look kind of
horrific. And they’re not wrong...
but the benefits vastly outweigh
the silliness for me.

The simplest set of affordances
in EyeSight are the way it clouds
your “eyes” depending on what
your visibility inside the headset
is — if I can’t see your eyes, you
can’t see me. If I can see your eyes
but there’s light swirling around
them, you can see me but may be
distracted. If I can see your eyes
clearly, then you can see me
clearly, easy.

But the second level of
affordance is that you can still
communicate using the eyes
themselves. Sensors on the inside
are reading your face, which means
that if I speak to you, you can still
make eye contact with me. I can
see that even with the headset on,
I do have your attention. I can see if
your attention drifts for a moment,
distracted by some notification or
3D dinosaur video. And then I can
see if you suddenly tune me out, as
your eyes go cloudy mid—-sentence,
which is sure to become a power

It might not be a full, romantic, gazing
into each other’s eyes experience,
but it's a lot better than nothing.

move in any office where Vision
Pro is actually used.

But that’s the key — this is the
kind of thing that shows Apple is
thinking about people using this in
the real world. It solves an actual
problem, enabling you to stay in
the headset for longer, rather than
wearing it becoming a hassle
because you need to take it off
constantly to talk to people
because it’s not enough that you
can see them — they need to see
you too. Does it look silly? Yeah,
sure, okay. So did AirPods at first.
Then we got used to them. Then
they took over the world.

>>> Matt is Managing Editor at Future's flagship technology website TechRadar and has been charting changes at Apple since
his student days. He's skeptical of tech industry hyperbole, but still gets warm and fuzzy on hearing “one more thing.”
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LETTER OF THE MONTH

Nick, “New is not new anymore” is
exactly why I am so frustrated.
Underpowered base models,
outrageous upgrade prices for larger
memory and SSDs, and what I believe
is deliberate downgrade performance
in base model SSDs to force you to
spend more. Improvement? The
testing on the M1 base SSDs
outperforms the new model from
what I have read. How does that
happen? Just like your desk, office,
and the environment affect your
productivity, I need a change to
inspire creativity. Darn, I have to sit
in front of that computer for hours.
Anyway, thanks for saying
something that a lot of people are
thinking and has probably stayed
hidden from their marketing. It’s so
refreshing to see journalism and
critiques instead of just telling Apple
how great they are! If they don’t
watch it, in the current economy,
they will go the way of many luxury
car dealers that are struggling
because the $60,000 category only
buys an average car right now! $400
for a RAM or SSD to upgrade an
underpowered Mac is obscene.
BURT ALLAN

We’re not in total agreement about the
base models — if anything I’d say you
get such great performance from the
standard Apple silicon models that
there’s less reason to upgrade (which
was one of the points [ was trying to
make), though as ever storage is rather
paltry. We were pretty pleased about
the unveiling of the new MacBook Air
at WWDC23. The new 15—-inch option is
very appealing, and along with the
impressive M2 performance, it’s going
to be great (check out[p&Z)). OK, it’s not
revolutionary, but it’s what most
people want. Apple has also redeemed
itself somewhat with the launch of its
exciting new Vision Pro too.

More digital options

| enjoy the new all-digital
format and used the link you
provided in the June 2023
edition to download the
Mac|Life app for my MacBook
Pro with M1 chip. The app
works fairly well but crashed
on me a couple of times. Based
on that, | went back to the way
| read the digital edition in the
past, Apple News. | don't recall
you mentioning that readers
could read their digital edition
in the Apple News app in the

past. | thought readers may be
interested in knowing that is
an option.

MIKE ROBERTS

Michael, the suggestion is
greatly appreciated. Apple
News is a good alternative,
provided you are going to
get the most out of that
$9.99/month subscription.
Mac|Life is only $20/year, so
unless you're reading a lot of
different titles, then it's not
the most cost-effective

SHARE WITH US! EMAIL:[letters@maclife.com

FACEBOOK:facebook.com/maclitd TWITTER:[Ewitter.com/maclitd

option. In future it's worth
updating the Mac|Life app if
you have any problems, as
often we do updates shortly
after a bug is detected.

Paper is proper

I'm not a geek — | already miss
the real magazine. | could tear
out pages to save.

PAT QUINN

We miss the printed
magazine too Pat! However,
there are some benefits to

| the digital version, one of

which is you don't need to rip
up your issues to save pages
as there’s a bookmark
option, which means you can
keep your favorite pages
right in the app. Plus, you
don’t need to worry about
storing pages somewhere
safe, and you can access
them anywhere you are.

Two True Tone —

no go

Up until a week ago, | had a
Studio Display paired with my
Mac Studio (running Ventura).
As a treat for all my hard work, |
bought a second Studio
Display. Setup was a breeze — |
connected each monitor
directly to the Mac Studio. My
issue is | cannot seem to get
both monitors configured for
True Tone. It appears only the
primary display has the option
to enable True Tone. The
difference is quite noticeable
when one monitor is True

Tone enabled and the other

is not. Help!

SCOTT PELUSO

After a bit of back and forth
with Scott, there didn't
appear to be an obvious
reason why there would be
this limitation. We suggested
that he got in touch with
Apple Support, which he did,
and they explained that this
was a bug, as we initially
thought it might be.
Unfortunately Apple didn't
give Scott any idea as to
when this bug might be
fixed. Probably, there won't
be too many of you out there
privileged enough to be
running two Studio Displays,
or so we think!

Mac|Lifes®
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Mac malware
on the rise?

The bad guys are coming for your Apple devices —
we find out why. WRITTEN BY CHARLOTTE HENRY

I_ —l acs don’t get malware.
M That was the old adage.
However, over recent
|_ years, that has proven to
be increasingly inaccurate, if it was
ever true in the first place. There are
now all manner of software nasties
designed to attack Macs and other
Apple devices.

Paul Ducklin, principal research
scientist at Sophos, told us that
decades ago, Macs and other minority
platforms didn’t get viruses “probably
because people who wrote them
weren’t that interested, or there
weren’t that many people interested.
But it kind of became almost like this
touchstone, that it’s obviously some
magic smoke that got baked into my
operating system of choice. ‘I chose a
Mac that’s a minority system.

I haven’t seen any viruses, my
Windows and my DOS chums are
getting them all the time. It’s either
I’m very clever, or there’s something
fantastic and immune about Macs.’
And unfortunately, it doesn’t quite
work like that.”

Indeed, such a mindset can lead to a
false sense of security among Mac
users. If we think our computers are

8 | AUG 2023

somehow impenetrable, we might end
up forgetting to do the cybersecurity
basics, leaving ourselves vulnerable.

It is not like there aren’t issues to
be aware of. For example, recently an
information stealer branded
MacStealer was discovered by the
company Uptycs and other
researchers. This is not something you
want on your device.

“The stealer can extract documents,
cookies from a victim’s browser, and
login information. It affects Catalina
and subsequent macOS versions riding
on Intel, M1, and M2 CPUs,” explained
Uptycs researchers Shilpesh Trivedi
and Pratik Jeware. The malware was
being pushed on anonymous
messaging app Telegram.

Trend Micro also
detected that same
malware, which their
report described as “a
cryptocurrency wallet and
information stealer
disguised as a plagiarized
version of a legitimate
play-to—earn (P2E) game
app”. Trend Micro
researchers Qi Sun and
Luis Magisa advised: “To

Paul Ducklin dispels the
popular myth that Macs
can't get malware.

avoid and defend against threats like
MacStealer, we strongly advise being
wary of installing apps from unofficial
sources and app platforms. Enabling
the latest security solutions for
devices can also help detect, block,
and mitigate the risks of these kinds
of threats.”

This is a good approach to keeping
your Mac safe in general. While it is
true that Mac malware is less
prevalent in comparison to what
attacks other platforms, there is still a
wide range of it floating around. In
another incident, ransomware, which
usually encrypts and scrambles data
on a victim’s device until a sum is paid
to the attacker, has been detected for
macOS. Such attacks on
Macs had basically been
unheard of before. (It is
worth noting that
coughing up is never a
guarantee that you will get
your data back and is not
necessarily advised by
security experts.)

In a blog post about the
ransomware, Ducklin
outlined how it worked:
“The crooks hacked into &

Image rights: Sophos Ltd.
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Using a Virtual Private Network (VPN) such as NordVPN can help keep you safe on public Wi-Fi.

the download server of a popular
BitTorrent client called Transmission,
created a fake version numbered 2.90
and published it as an official
download on the site. The
Transmission app itself was very
slightly modified to include an
additional snippet of code to run the
malware, which was added to the
Transmission package under the
innocent-looking name General.rtf.”

He highlighted that this piece of
malware does not require a user to
enter a password to gain full
administrative powers: “That means
you won’t see any dialogs popping up
asking you to provide your

administrative password. Some Mac
users still wrongly think that a
password dialog is an inevitable
side-effect of a malware infection,
and is thus a handy way to spot that
something malicious is about to
happen, but that’s not correct.”

APPLE'S APPROACH

Apple cares deeply about all this. It
wants its users to be safe and has a
variety of support documents
explaining how we can all take simple
steps to protect ourselves.
Furthermore, security is cited as a
reason why it has not yet allowed
so-called sideloading on iPhones and

WE CAN ALL
ABSENTMINDEDLY
CLICK ON A
DUBIOUS LINK OR
OPEN A HARMFUL
EMAIL ATTACHMENT

iPads, insisting that all software is
downloaded from the App Store. The
Mac ecosystem is somewhat freer, as
users are not limited only to software
that is available via the Mac App Store.
Of course, we can all absentmindedly
click on a dubious link or open a
harmful email attachment.

Ducklin said that while part of the
reason Apple forces iOS users to
download only from the App Store is
about controlling the platform, this
“did have the effect of controlling
malware much more strictly on the
iOS platform than we originally saw
with Android and certainly on
Windows, and even on the Mac where
it’s a bit more of a free-for-all.”

BEING PROACTIVE

However, Ducklin warns: “Anybody is
allowed to submit a program to Apple,
and anybody is allowed to have that
program accepted into the App Store,
whether it’s for Mac or iOS. So, on a
Mac, you can lock yourself to the App
Store, on an iPhone or an iPad you

Top tips for staying safe

None of these tips are a guarantee of safety, but they can all help a bit

Limit the number of
administrator accounts

Apple recommends using mostly standard
user accounts. Only admins can download
and install software, reducing the risk of
malware spreading.

10 | AUG 2023

Run antivirus software

This can spot any nasty software you may
have downloaded, hopefully stopping you
installing it before it becomes a problem. It
can also clean your computer if you do
install something problematic.
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Check sender or developer
Itis worth double-checking who an email
is from. Do you know the sender? Is this
their real email address? Similarly, make
sure software you install is from a known,
trustworthy company.

Image rights: Apple Inc, Nord Security, Sophos Ltd.



have no choice. But even then,
Apple’s trying to keep things open
enough to have thousands or
hundreds of thousands of developers.
“Google’s doing the same. They
don’t actually look at the code in every
app; they put it through some
automated tests. Malware even gets
into the so-called walled gardens.”
Part of the reason why Mac malware
is seemingly growing might simply be
that because there are more Macs in
the world, attackers are more
interested in going after them. It was
just not worthwhile to them before.
Apple had also been criticized for
not having a proper bug bounty
program, unlike other companies.
Such programs reward security
researchers, often handsomely, for
finding and reporting vulnerabilities
to the company so it can fix them.
This can encourage more research and
lead to issues being discovered and
stamped out more quickly. Finally, in
December 2019, Apple launched a
program that was expanded beyond
just iOS devices, meaning Mac issues
were included, and was not just
invitation based. The company also
increased rewards to a maximum of S1
million, depending on what type of
issue a researcher found.
Apple is also taking a much more
proactive approach to tackling these

==
dervice i focked

Apple finally launched a bug bounty program in 2019.

issues, starting to push out updates
for both macOS and iOS that deal with
one single problem, instead of waiting
for weeks to push a fuller version
update that deals with a variety of
malware all at the same time. Indeed,
the company recently pushed out its
first Rapid Security Response for the
iPhone, separate to any wider iOS
update. This might seem a scary thing
to receive as a user, but it is positive
that potential problems are being
tackled quickly.

A key issue that might trigger such
aresponse from Apple is a “zero-day”
— a previously unknown piece of
malware — being found out in the

Lotk Seresn: can st photon whits

wild. Again, the company is taking
robust action against such problems
and visibly fixing them, which might
actually be a positive.

“Are we getting more zero—days,”
Ducklin asks, “or are we just getting
better at finding them and fixing them
really quickly, and getting people to
notice them and warn the world? And
Ilike to think that it’s the latter.”

Overall then, Mac malware has
become something that we all need to
pay more attention to. But by
following some good digital hygiene,
and thanks to growing support from
Apple, we can continue to use our
computers safely and effectively. m

Usea VPN

A VPN like NordVPN or ExpressVPN
creates a secure internet connection. This
offers an extra layer of protection,
particularly if you're using public Wi-Fiin a
coffee shop, airport, etc.

Use up-to-date

operating systems

Apple regularly updates its operating
systems, and these updates include
security fixes. Itis worth installing these to
make sure you are protected.

Use App Store software

Using the App Store on Mac, iPhone oriPad
is no guarantee that a piece of software is
okay, but it's generally better to download
from there than to get random programs
from the web.

AUG 2023 | 11
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Is Vision Pro the future
market leader, or just an
overpriced gimmick?
We look at the history
and future of virtual
and augmented reality

WRITTEN BY IAN OSBORNE



THE PAST, PRESENT
AND FUTURE OF
SPATIAL COMPUTING

+ + 4+ +

I
I

+ + + + + 4

IRTUAL AND AUGMENTED reality have been sci—fi
v staples for years. Virtual reality puts you in an

alternate world, where you can look, move and
interact as if you were really there (think Star Trek’s
holodeck). Augmented reality overlays computer—
generated graphics and information over the real world, so
you see both through your glasses or on your screen (like in
Pokémon Go). These concepts have a longer history than
you realize in the actual world too.

Over the last few years, the technology has matured to
the point where it’s ready to change the world. We’re
promised immersive games, with the player at the center
of the action. Video chats could be transformed, with the
participants sitting around a virtual table in a virtual living
room or office, probably drinking virtual coffee. Your
augmented reality glasses could be used to find directions,
which could then be superimposed on the street as you
walk or drive. And if promoters replaced a seat at a concert
or sporting event with a 360—-degree HD camera, they could
sell that seat hundreds of times over to virtual reality
enthusiasts all over the world.

Here we look at the past, present and future of virtual
and augmented reality. Where it came from, where it’s
going, and how Apple fits into this space.

+ + 4+ +

Vision Pro

+ + + +
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0 Feature
The Past

VR and AR have been around longer than you think

14 | AUG 2023

HE ROOTS OF virtual reality can be traced
T back to 3D games and software where the
environment is viewed from a first-person
perspective. And these didn’t start with Doom
either. Which was the first such title is disputed;
it’s either space shooter Spasim or the blaster Maze
War, both of which were released around 1974. They
weren’t actually virtual reality, of course. The
gamer played them on a computer screen, just like
any other game. But it’s here one of its key features
was established; the environment was viewed
through the player’s eyes, instead of their being
represented as an on-screen avatar. Later first—
person games included the ZX81’s 3D Monster

Maze, Wolfenstein 3D and, of course, Doom.

From these basic first—person video games, the
first—person shooter genre eventually took shape.
When computers and consoles grew powerful
enough, as well as moving through a virtual 3D
environment, you could also look around in a 360-
degree space by moving your in—-game head. You
now had the ability to look up and down, not just
left and right.

Headsets with motion tracking had been worked
on since the 1960s, mostly by the military for
training and viewing dangerous situations. Myron
W. Krueger’s VIDEOPLACE appeared in 1975, and is
generally regarded as the first interactive VR

Much was expected from Google Glass, the augmented reality smart spectacles, but they never caught on. They were expensive, and lacked a killer feature.

Imaage rights: Google Inc.



Vision Pro

When the Legend Quest virtual reality arcade
opened in 1992, there was nothing else like it.
Four gamers played together using VR headsets,
with motion tracking and hand controllers to
look after movement and actions. The player
stood inside a circular barrier while playing, to
make sure they didn’t trip over anything in the
real world while they explored the virtual one.

The hardware used was based on seven
enhanced Amiga 3000 computers. It could move
30,000 flat-shaded polygons at 20 frames per
second with a maximum of 250 objects, though it
slowed when there was too much happening on
the screen. The helmet, which contained motion
tracking technology to see which way you were
facing, completely covered the eyes with a small
viewing screen in front of each eyeball. A speaker
over each ear carried the sound effects, creating
the impression of which direction a sound came
from. It was true virtual reality, albeit primitive by
today’s standards.

THE LEGEND QUEST HARDWARE

In Dactyl Nightmare, you had to shoot rival gamers with your virtual pistol. If you were

hit, you respawned; the player with the most kills wins.

system. It didn’t feature a helmet, but its cameras
and screens could measure the position of the user
and react accordingly. The VITAL helmet, developed
as a pilot training tool by McDonnell-Douglas,
included a head tracker. Also of note is Ivan
Sutherland’s Sword of Damocles, a head—-mounted
display which hung from the ceiling and added
computer—generation graphics to the user’s
perception of the world.

A NEW WORLD OF VR GAMING

The term “Virtual Reality” was coined in 1987, by
Jaron Lanier. His company, VPL, went on to release
the Dataglove and the EyePhone head—-mounted
display. They’re a major milestone in the history of
VR, but way too expensive to become mainstream.
The term “Augmented Reality” came from
researchers Thomas Caudell and David Mizell, who
used it for a head—mounted display for aircraft
construction at Boeing.

At the start of 1992, a virtual reality arcade
featuring two VR games opened in Nottingham, UK.
Legend Quest saw four players at a time compete in
the sci—fi themed Dacty! Nightmare, a death-
match where you blasted other players while being

Image rights: Legend Quest, Epic Games

stalked by killer pterodactyls. There was a fantasy
role—-playing game also called Legend Quest, where
you played a warrior, wizard or thief and chose from
three character races: human, elf or dwarf. It gained
a decent cult following, but it wasn’t widely
franchised as had been hoped.

First-person games like Unreal Tournament let you look around in 360
degrees by using a mouse or joystick to move your in-game head.

AUG 2023
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The most popular virtual reality system for home consoles is Sony’s PlayStation VR.

Home VR got off to a slow start. The Sega VR
headset for the Sega Genesis/Mega Drive console
was revealed at the 1993 Consumer Electronics
Show, but never released. Ten years later a
Kickstarter was launched which eventually led to
the popular Oculus Rift, which was soon bought by
Facebook. The Oculus Quest 2 is currently the best-
selling VR headset of all time.

Google Glass proved much less popular. First sold
as a prototype in 2013, it was underpowered and
cost $1,500, which proved too much to allow it to
find its niche in the nascent home spatial
computing field.

Home VR gaming is still being fought over. As
well as the aforementioned Oculus headsets (now
known as “Meta”), Sony’s PlayStation VR has sold
over five million units, the Valve Index is great for
VR games on Steam, and there’s HTC Vive and
Samsung Gear VR to choose from too. Microsoft’s
HoloLens has been promised for years, but as of
yet, it’s not available to consumers. A public release
has yet to happen.

And if you’re on a budget, there’s always the
unpowered VR goggles that house your smartphone
and are used to watch online VR videos. Some
people love them, but they can be very unkind to
those who wear glasses.

16 | AUG 2023

Vision Pro faces some stiff competition from
the leading virtual reality options already
available. PlayStation VR, for example, is
relatively affordable, runs quality, ambitious
games and is comfortable to wear. The HTC
Vive Pro 2 is more expensive, needs a
decent-specced PC, and can look a little
foggy at times, but its hardware is very
comfortable to wear and overall picture
clarity is good.

The Valve Index is another VR system that
needs a PC; it still doesn't support macOS. It's
prohibitively expensive too, costing $999. But
if you're serious about virtual reality, it has
excellent picture quality, a superb 130-
degree field of vision and some of the best
controllers available on a home VR system.
The very affordable Samsung Gear VR was
once a no-brainer if you had a Samsung
Galaxy smartphone, but the device is steadily
being discontinued and doesn’t support
devices that update to Android 12.

Our favorite current virtual reality system
is the Meta Quest 2 (formerly Oculus Quest
2). It's very well priced, requires no other
hardware and gives an incredibly immersive
experience. Look out for the new Meta Quest
3 in the fall too.

Image rights: Sony, Meta.



Vision Pro

The Present

What's unique about Vision Pro,
and how did it reach fruition?

PPLE HAS LONG been interested in what
A it’s now calling spatial computing. As
early as October 2020 the company
introduced a LiDAR scanner in the iPhone 12 Pro. It
stands for Light Detection and Ranging, and is a
remote sensing method that uses a pulsed laser to
measure the distance between the device and
surrounding objects. This gives an excellent 3D
impression of the room. It’s great for augmented
reality features, like trying out new furniture before
buying by superimposing its graphic onto the room.
For third-party developers, Apple released
ARKit, offering augmented reality frameworks and
tools for them to use. There are some great
augmented reality apps and games available on

Apple’s app store, and you can check them out at Apple’s CEO Tim Cook shows off the new Vision Pro at the Worldwide
nttps://bit.ly/3Xn7tMQ. Developers Conference, 2023.

After years of development, this technology
comes into its own with the Vision Pro. These VR/

AR goggles “seamlessly blend digital content with You can watch movies on the new device for a
your physical space”. Announced at WWDC23 in real cinema-like experience. Apple TV+ is a no—
June and due for release “early next year”, Apple’s brainer, we’re already promised Disney+, Netflix
“first spatial computer” gives you an interface seems inevitable, and providers of TV streaming
superimposed on the real world which is controlled and catchup services are sure to release their own
with your eyes, hands, and voice. Its operating apps too. Naturally, gaming on such a large virtual
system is visionOS, which has a home page that screen would also be great fun.

resembles iOS and macOS-like windows with which

you interact. Vision Pro’s ultra-high—-resolution A BLENDING OF WORLDS

display system packs in 23 million pixels, and it As you’d expect from Apple, a lot of attention to
runs on an Apple silicon dual—-chip system. An M2 detail has been taken with the interface. It’s

chip takes care of the processing, while a new R1 sensitive to light, adapting to ambient conditions
chip handles input from the device’s 12 cameras, and in—room decor, so the windows and menus
five sensors, and six microphones. become part of the room. They even cast virtual

visionO0S INTERFACE

VisionOS is instantly familiar to anyone who's used an
iPhone or an iPad. Apps are presented as icons, but you
open and close them with hand gestures and voice
commands instead of tapping a screen.

Some of the apps will also be familiar to existing Apple
fans, as will their functions and features. The Photos app, for
example, syncs with your iCloud data and shows your
pictures and videos, crystal clear and imposed on your
physical space. You're no longer limited by the size of your
screen. You can make your apps any size you want. The vision0S interface is clearly inspired by i0S and iPad0S.

Image rights: Apple Inc. AUG 2023 | 17
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Vision Pro Hardware |

keeps out ambient light. Crown and a button.

3D GOGGLES CONTROLS SPATIAL AUDIO THE BATTERY HEADBAND
Two micro-OLED displays The device's controls The speakers are positioned  The external battery, The headband is breathable
each deliver more pixels than are clearly inspired by Apple  close to your ears, and connected to the headset and stretchable for comfort.

a 4K TV, and a light seal Watch. There’s a Digital deliver 3D audio that blends  with a cable, provides A Fit Dial is used to make
with real-world sounds.

around two hours of use. sure it's snug.

As with most recent Apple products, communicationis
at the heart of Vision Pro. FaceTime calls are catered
for, with each participant in the video conversation
appearing in a different tile. You can scale and position
the tiles however you please, and to make conversation
more natural, the device's spatial audio features make
it appear that each person'’s voice is coming from the
location of their tile.

You can use your Vision Pro to create a very realistic
digital avatar of yourself. This allows others to see your
face while you're wearing Vision Pro in a video chat,
dynamically following your head and hand movements.

18 | AUG 2023

shadows, offering a sense of scale and distance.
You can move apps around the room, and expand
or reduce their size by dragging corner handles.

You don’t have to use your own room as a
backdrop either. Apple’s Environments are scenes
from around the world which you can use as the
equivalent of an i0S/iPadOS wallpaper or a macOS
desktop image. You can even use a blend of the
two, turning the device’s Digital Crown to set how
immersed you are.

As well as bringing existing technologies on
board, Vision Pro is packed with new innovations.
Take EyeSight. As Vision Pro augments your
environment rather than taking you out of it
completely, while using the device your eyes are
shown on the back of the goggles. If you choose to
immerse yourself in the virtual environment, so
you can’t see those around you, your eyes are
replaced by a colored pattern so others know you
can’t see them. Vision Pro is also Apple’s first ever
3D camera. You can take pictures and videos in 3D,
and relive those memories as never before. It’s
amazing what we might be able to achieve with
Apple’s first spatial computer.




You can use your Vision Pro with a keyboard and trackpad, giving
you a complete computing experience in augmented reality.

The Future

Where next for spatial computing
and the Apple Vision Pro? We take
alook at what to expect

HE TECHNOLOGY BEHIND Vision Pro looks

great, but as Apple is well aware, tech is a

means to an end not an end in itself. What
will the company’s first spatial computer be used
for? And how will it find its place in the modern
home and office?

With apps like Safari, Keynote, Calendar,
Messages, Notes, Freeform, the Microsoft Office
suite and more, Vision Pro could be a real boon for
work, and not just for remote video meetings. You
can, for example, use the Messages app to send 3D
images as well as regular missives, pulling them out
of the app and exploring them in your own space.
This is great for industrial designers, architects and
engineers, for example, and others who might need
to share prototypes.

One of the ways Apple increased the iPhone's market
penetration was to release a lower-cost device for
entry-level users: the iPhone SE. Could the company
take a similar approach with the Vision Pro?

Being such a new device in an emerging market (unlike
the iPhone, which was preceded by many other cell
phones), we would expect the Vision Lite (or whatever
Apple calls it) to arrive early in the product’s life cycle;
maybe as early as a year after the release of Vision Pro.
Where Apple would make the savings required to keep
the retail price down is a puzzle, but maybe a year’s
worth of Vision Pro production would pave the
way for a lower-cost device with fewer
components. Perhaps a new Apple silicon
chip could integrate the M2 and R1
chipsets, for example, in a lower priced but
less powerful alternative?

Devices like the Meta Quest 2 come in at
less than $300, which is affordable enough
to satisfy even if you only use it occasionally.

We doubt a Vision Lite could ever reach this
price point, but it needs to be no more
expensive than around $1,200.

When watching the room as well as content,
your eyes are shown on the goggles.



o Feature

It could prove great for entertainment too. As
we’ve already said, it provides a real immersive
experience when watching TV or movies (including
3D movies), and as the Music app is included in
visionOS, you can listen to your tunes too. On
launch we’re promised over 100 Apple Arcade titles
that can be played with Vision Pro, which offers full
controller support, and games that make full use of
its augmented and virtual reality capabilities will

But will Vision Pro last long enough to achieve its
goals? Two main challenges stand between Vision
Pro v1 and the sort of mass adoption it needs to
succeed: price and battery life.

A PRICEY PROPOSITION

When Vision Pro is released early next year (or so
we’re promised — there may be delays), it will cost
$3,499 in the US. That’s more than most Apple

surely follow.

notebooks. Even if it’s worth the price, people

FACETIMING WITH VISION PRO

Although vision0S is a completely
new platform, its frameworks and
tools are already familiar to Apple
mobile developers. So despite
being new, it shouldn’t be a major
challenge to program visionOS
apps for the headset.

visionOS apps can include one or
more windows, which are built with
SwiftUl. As well as traditional controls,
developers add depth with 3D

content. Apple’'s 3D rendering engine,
RealityKit, is used for 3D content,
animations, and visual effects. ARKit
understands your surroundings and
powers core system capabilities that
apps automatically benefit from
when they're in the Shared Space.
Games programmers can use Unity,
which has access to the benefits of
visionOS, making titles created on the
platform look right at home.

Alta flomee = C43

This vision0S app, built with an early development kit, monitors the air flow over a racing car.

AIR FLOWS
A key goal of

ENCOUrEga NEW a8
closer and exciling racin
performs exceptionally well, with
many exciting overtakes throughout the s83s0n.

This low entry bar should work in
Apple's favor, reducing the
commitment required, and therefore
the cost, of developing apps for the
new platform. Even so, making the
best use of Vision Pro’s technologies
will still take time, effort and (most
importantly) money. We expect early
releases will be “shovelware”, that is,
created for other Apple platforms and
tweaked for a visionQS release.

changes was to
2022 regulation changes _w _
i ‘r;)dynarali: affects, allowing for much
g. In this aspect the c43
the expectation of
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“[Vision Pro] marks
the beginning of a

journey that will bring

a new dimension to
powerful personal
technology.”

TIM COOK, CEO

:ﬂ-cﬁ‘__..-r

“Vision Pro lets
developers
reimagine existing
apps and create
brand—-new ones.”

SUSAN PRESCOTT,
VP, WORLDWIDE
DEVELOPER RELATIONS

“Apple Vision Pro
allows us the
freedom to imagine
and experience
unlike anything
we’ve created
before.”

ALAN DYE, VP,
HUMAN INTERFACE

Image rights: Apple Inc.

won’t spend that much — especially on a new and

untested piece of tech — without careful
consideration. Potential purchasers might well
hesitate, watching the Vision Pro scene develop and
mature before joining it. If initial sales are slow,
developers and content providers might do the
same, reluctant to invest resources on a platform
with a limited user base. This could create a vicious
circle where the public and the industry alike adopt
a “wait and see” attitude, with developers waiting
for more sales before getting on board and users
waiting for more content before buying, preventing
Vision Pro from achieving the early market
penetration it needs to become a success.

RESTRICTED FREEDOM?

The other major challenge is battery life. Putting
the power supply in an external unit you can keep
in your pocket was a good move; much better than
housing such a heavy component in the headset.
But it lasts just two hours! That’s not enough to
watch most movies. You can plug it in, of course,
fine when you’re sat down for instance, but
otherwise you’re tethered to a single spot, without
the freedom advertised in the Apple keynote.

No doubt when Vision Pro is released spare
batteries will be on sale in the Apple Store, with
third party devices to follow. And hopefully, you
can unplug the dead one and connect a new cell
without turning off the headset. Even so, battery
life is a key element that Apple will have to address
going forwards.

There can be no doubt that Vision Pro is an
exciting piece of kit. We’ve seen augmented and
virtual reality systems before, but is this the first
device to get it right? Only time will tell.

| of
1d history
nissed

You can send and receive 3D objects using Vision Pro, and look at
them from every angle.
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Master Split View in mac0S

Work with two apps at the same time by slicing your Mac's screen in two

REQUIRES
macO0S 13 or later

YOU WILL LEARN
How to work across two
apps by having both
displayed on screen

IT WILL TAKE
3 minutes

=

GENIUS TIP

Can't get Split View to
work? Then go to Apple
menu > System Settings >
Desktop & Dock and
activate “Displays have
separate Spaces”.

Svins

AUG 2023

WHEN YOU'RE WORKING on your
Mac, you can find that your

'sl  desktop becomes cluttered with
C4S numerous windows, making it
more dlfﬁcult to focus on the task at hand.
Many users will spend time resizing and
moving those windows or making an app fill
the screen. But there’s thankfully another,
more efficient way to manage your
workflow: Split View.

As the name suggests, you can have two
apps displayed side by side so that you’re
not constantly clicking back and forth across
scattered windows. Each app automatically
fills the screen from top to bottom,
removing the Dock and hiding the menu bar
to ensure that the important parts are on
display. This also saves lots of time —
there’s just a single way of adjusting how
much you see of each app.

HOW TO Use Split View on Mac

You’re not restricted by the apps you use
either. In fact, you can even place two
windows of the same app next to each other;
for example, you can have two instances of
Safari open if you want to refer to two
different websites at once. DAVID CROOKES

iPhone 14 Pro

Select an app
" For Split View to work, you'll need at least
two apps open on your desktop. Select one app
that you want to work with but, rather than mess
around dragging and positioning it, hover over
the top-left green button.

|Phone 14 Pro

Left or right

The Split View menu shows three choices
but, in this instance, you only need to consider
two of them. Simply decide whether you want
this particular app window to appear to the left or
right of your Mac's screen.




iPhone 14 Pro

LS

Select second app

The app will move into position, taking up
exactly half of the screen space. You will see any
other apps that were open on the Desktop in the
other half. Just click the second open app that
you'd like to work with.

iPhone 14 Pro

Swap them over

Click an app in Split View to work with it,
or move the pointer to the top of a window to see
its menu. Windows can also be swapped around
by selecting and holding the top of one and
dragging it left or right.

Use Mission Control

You can also switch to other apps via
Mission Control. Either press the Mission Control
key (F3), swipe up with three fingers on a
trackpad, or double tap the Magic Mouse with two
fingers, and the desktop appears.

Image rights: Apple Inc, Microsoft.

How to do anything on your Mac, iPhone & iPad

iPhone 14 Pro

Make more room

The second app will then fill the other half
of the screen, sitting side by side. You can adjust
the width of the windows, giving more space to
one and less to another, by dragging the vertical
line that runs between them.

M =0 Replace Tiled Window

=] Move Window to Desktop
c @ Make Window Full Screen

My Places

3 Places

Replace a window

Want to work with a different app? Hover
over the green button of the window you wish to
remove and select Replace Tiled Window. Then
select any other open app on the Desktop. The
other two options end Split View.

Use Mission Control to switch between
the desktop and an existing Split View. You
can create a Split View from scratch too; just drag
an app onto a full-screen app thumbnail in the
Spaces bar of Mission Control.

GENIUS TIP

Tiling on a Mac refers to
two apps running
simultaneously. They're
different from Microsoft
Windows Live Tiles which
once represented apps in
the Start menu.

JARGON BUSTER

To exit Split View, you can
just click the green full-
screen button on the app
window you don't want to
keep using. The other app
will fill the screen.
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Turn audio into text

Transform spoken audio into editable, searchable, usable text with MacWhisper

Export SR a

across to Ayrshire on the west. I'd started off in Inverness and moved down to West Lothian where

different part of Scotland where my accent was now deemed too raugh. One of the people who told me

this was my next door neighbour, an older boy who wasn't very nice to me but who grew up to be a

very nice man. He's my sccountant now but | have a long memory and | never pay his invoices on time.

I'wasn't bulled much though. I'd have the odd parka pulled over the head encounter,

w @ Q8 -

Tus 28 Mar 17133

REQUIRES
MacWhisper, mac0S 12 or
later (M-series Mac
recommended)

YOU WILL LEARN
MacWhisper can turn
spoken audio into
usable text

IT WILL TAKE
Depends on task

=

GENIUS TIP

If the app you want to
transcribe from doesn't
save or export audio,
Rogue Amoeba’s Piezo
[roqgueamoeba.con)

— a simpler, cheaper
version of Audio Hijack
— will do it for you.
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MACWHISPER IS A clever
Al-powered app for Mac

that quickly and accurately
transcribes spoken text from
live audio, recordings, and videos. It has
been trained on nearly 700,000 hours of
audio data, and unlike online transcription
services it runs natively on Mac so it’s
always available. Unusually for a free app,
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Transcribed text appears as it's recognized, and you can
edit it in place or quickly play the original audio to work out
what's being said.

MacWhisper|(goodsnooze.gumroad.com)
doesn’t keep its best features locked away or
blast you with ads. It simply gets on with the
job, and the only real limitation is that you
don’t get its very best language models, and
text and subtitles output doesn’t include
HTML or PDF.

CLEVER RECOGNITION

There’s lots to like here, including in-place
text editing and the ability to separate your
transcript by speaker if there’s more than
one person in it — great for transcribing
meetings, podcasts, and other potentially
confusing multi-speaker setups.

Given that it’s free and ad-free, this app is
superb value — but its paid-for incarnation,
MacWhisper Pro (currently around $20), is
great value too. It enables you to use even
more accurate recognition models, using
larger speech databases. The more accurate
the transcription, the slower the recognition
process — roughly two-and a-half times
slower — but the results are incredibly
impressive. We threw a full chapter of an
audiobook at it and it didn’t make a single
mistake. CARRIE MARSHALL

Image rights: Apple Inc, Jordi Bruin.
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HOW TO Transcribe audio with MacWhisper

Choose your input

MacWhisper can work with two
kinds of audio — live and recorded. To
use the latter it needs to be in one of the
formats MacWhisper recognizes: MP3 or
WAV for audio-only files; or M4A, MP4, or
MOV for videos containing audio.
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o Display your
document

Transcribed text will appear as the file is
analyzed. Once finished, you can see the
whole thing by tapping the Readericon in
the toolbar. MacWhisper will try to guess
line and paragraph breaks.
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Export the text

You can export the transcribed text
in two ways - using the Copy icon in the
toolbar, or the Export one next to it. The
latter offers various text formats; paying
customers also get HTML and PDF. We've
copied and pasted into Pages.

Image rights: Apple Inc, Jordi Bruin.

Drag your file

To use an existing audio file, drag
it over the MacWhisper window. If it's in
a non-English language the app will try
to recognize it, but if you want to avoid
possible confusion you can say exactly
what itis in the Auto Detect drop-down.
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| stories. | spent alot of ime daydreaming about them or saving in
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B Change the breaks

If you'd rather get the text as
one big block, simply click on the icon
immediately to the left of Copy at the
top-right of the Reader panel. This toggles
between different layouts but leaves the
transcribed text unchanged.

rem T e .

o

Transcribe

in real time
You can automatically transcribe live audio
from a mic or other connected audio device.
You'll see a microphone icon as you record
(future versions of the app will show the
transcription on-screen as it's happening).

Let it listen

MacWhisper has to listen to your
audio in order to transcribe it — but it does
so very quickly. In this example, we dropped
a 20-minute MP3 onto the app: it
transcribed the whole thing on an M1
MacBook Pro in roughly three minutes.

Fix the fluffs

You should expect to see the odd
mistake, but if you encounter the same
error multiple times, you can click on the
Search and Replace icon in the toolbar
to find and fix those mistakes throughout
the transcription.

See what you said
The interface is the same when
using live audio. Once you stop recording,
the app will process the recording like it
did with the MP3 file (at the same speed).
You can then perform search and replace
before copying/exporting your text.
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REQUIRES
Affinity Photo 2
(hfinity.serif.com), $69.99

YOU WILL LEARN
How to modify adjustment
layers and filters using
live masks

IT WILL TAKE
15 minutes

THE FEATURE-RICH AFFINITY
A.v‘ Photo 2 now has a new collection
/A‘ of live masks that enable you to
- mask layer content based on
an image’s luminosity, hue, or frequency
(color and tonal range).
We covered the Live Hue Range Mask
in part one of this series of tutorials, so
here we’ll focus on how the Live Band-pass
Mask and the Live Luminosity Range Mask
enable you to take more control as you work
on an image. For example, when retouching
a portrait you can use the Live Unsharp
Mask to sharpen the shot. Sharpening

Understanding live masks

works by increasing contrast around edges,
such as eyelashes, for more impact.
However, this sharpening process also
exaggerates textures, such as skin pores.
Here, we’ll show you how to use the new
Live Band-pass Mask in conjunction with
the live Unsharp Mask to get a satisfactory
balance between sharpening details such as
eyes while preventing features such as skin
pores from being sharpened.

We will also utilize the new Live
Luminosity Range Mask feature to make
selective tonal adjustments to an image.
GEORGE CAIRNS

& AffinityPhoto2 File Edit Text Document Layer Select Arrange  Filters  View  Window  Help

Y

UNSHARP MASK
Despite its name, the Unsharp
Mask filter actually sharpens
image details by increasing the
contrast around the edges.

28 | AUG 2023
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LIVE BAND-PASS
MASK

Fine-tune the adjustments of
an attached filter by using

a greyscale mask.

ADJUST CONTRAST

These sliders, and the control points
in the Intensity Map, enable you to
adjust the range of detail affected by
the attached Unsharp Mask.

SELECTIVE SHARPENING
Lighter areas enable the attached
Unsharp Mask to give features
more impact. Black areas stop the
mask from exaggerating pores.


https://affinity.serif.com/en-gb/

HOW TO Use live masks to edit layers non-destructively

How to do anything on your Mac, iPhone & iPad

o Summon Unsharp
Mask

Click in a black area in the Layers panel to

make sure the image layer is not selected.

Choose Layer > New Live Filter Layer >
Sharpen > Unsharp Mask. The Unsharp
Mask filter will float above the image layer.

1

Sharpen the shot

In the Live Unsharp Mask box set
Radius to 1. This spreads the increase in
edge contrast by 1 pixel. Boost Factor to
4 for a higher-contrast change. This adds
impact to eyes but also emphasises
wrinkles and pores.

B Add Band-pass
mask

Click on the Unsharp Mask layer in Layers
panel. Choose Layer > New Live Mask
Layer > Band-pass. Click the Unsharp
Mask layer's drop—down icon to toggle
open the attached Live Band-pass Mask.

View the mask

In the Live Band-pass Mask

window, select Preview. The black areas
here stop the attached Unsharp Mask
from exaggerating fine details such as
pores. The white areas allow key features
such as eyes to be sharpened.

Edit the mask

Uncheck Preview to see the
image. Choose the Brush tool. Click on
the Live Band-pass Mask layer. Spray
a black brush over any wrinkles, lines,
and pores to manually mask the effect
of the attached Unsharp Mask filter.

Image rights: Apple Inc, Serif (Europe) Ltd.

Adjust the mask

Drag the Low Band slider left to O.
Drag the High Band slider right to 50. This
increases the contrast of the mask,
allowing the Unsharp Mask to sharpen
the brighter areas while stopping it
from sharpening skin pores.

£ High-contrast
W scenes

A Brightness/Contrast adjustment layer

brightens up underexposed shadows.

However, the sky’s become overexposed.

We need to make selective adjustments

with the new Live Luminosity Range Mask.

Increase intensity

=" The Intensity Map has a control
point at the top-right. Drag this left to
increase the brightness of the white
areas. The increased contrast allows
more sharpening in the whiter sections
of the mask.

0 Edit Luminosity
Range

In the Brightness/Contrast adjustment
layer, choose Layer > New Live Mask Layer
> Luminosity Range. Drag the curve
downwards to restrict the brightness
adjustments to the darker areas.
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Master Apple Music Classical

If your musical tastes are more Mozart than Miley Cyrus, then start here

REQUIRES 3. ARISING PHOENIX-LIKE from Listen Now
Apple Music Classical app, the ashes of Primephonic (which
an Apple Music subscription Apple bought in 2021), Apple Beethoven: Piano Concerto No.
Music Classical is a new app for 1in C Major, Op. 15
YOU WILL LEARN iPhone that’s solely dedicated to classical
How to use the Apple Music music fans. Available free to Apple Music
Classical app for iPhone subscribers (who pay $10.99/month),
it will both be instantly familiar to
IT WILL TAKE anyone who’s used that service, while also
20 minutes offering several unique features — including
improved search, 24-bit/192kHz audio, and
a laser-like focus on genres ranging from Alice Sara Ott, Netherlands Radio . r j
Orchestral to Experimental Classical, with Ehilharmonicitis & Karing Cana;.. :

its catalog of five million tracks arranged by
Composers, Conductors, and more.

While there’s no Mac or iPad app yet, it’s
worth checking out, especially as Apple has
teamed up with several of the world’s

APPLE HAS leading classical institutions — including
TEAMED UP the Berlin Philharmonic and the London
WITH LEADING Symphony Orchestra — to offer exclusive
CLASSICAL recordings. Note: while you can add Apple : :
INSTITUTIONS MUS’IC Classical track's Fo your library, you Beethoven: Lens: Shell Shock
TO OFFER can’t download music in the app. But, you wewn Debussy: Préludeala.. o oo
can use the Apple Music app to download Prélude & I'aprés-midi...
EXCLUSIVE tracks and playlists added to your Apple - . Q
RECORDINGS Music Classical library. ROB MEAD-GREEN B ﬂ o

HOW TO Get started with Apple Music Classical

Prelude

—— AN

— A

e

Lens: Shell Shock Mozart: The Complete T — A

. N. Lens: Lens: Shell Sh... n »

The Story of Classical: PartI

Apple

I. Canto of the Colonial... Nicola Benec:;letti - Schumann: E s
= Sz nowski - Chau... Symphonies Nos. 2 &... A
: °N =; ﬂ Q I_'.f:f-‘-_"_a ‘\S‘ Mi a in YIP {n, (Z--'i:-:?!'-o.' P Play
The Classical interface ) Listen Now . The Story of Classical

Apple Music Classical will be Here you'll be able to see all the This nine-part guide takes you on
instantly familiar to anyone who's used the latest Apple Music Classical releases atthe  a journey through the history of classical

Apple Music app before, with four buttons top. with any tracks you've recently music from the Middle Ages to the present
along the bottom for you to tap: Listen listened to available under the Recently day, with explanations and audio

Now, Browse, Library, and Search. First, Played section. If you're new to classical, commentary to help you get oriented.

let's start with Listen Now. scroll down to The Story of Classical. It's a great place to start.
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Browse

J

S’

Composers

o Start browsing

Tap Browse. At the top here you'll
find three tabs: Catalog, Playlists, and
Instruments. Tap each one to see how
Apple Music Classical has been organized
with each one containing sub-categories
such as Genres or Composers.

< £

Start listening

Here we've chosen “Yo-Yo Ma: Our
Common Nature”. Tap the Play button
below the cover artwork to start playing
the playlist. To add the playlist to your
library, tap the “+" button in the top-right
corner. Tap “." to perform further actions.

Library
() Albums
=" Playlists
J Tracks
4 Artists

Visit the library

Now tap the Library button. Here
you'll be able to see any of the works or
tracks you've added to your library,
arranged by Albums, Playlists and so on.
Note you'll only be able to play these if you
have an internet connection.

Image rights: Apple Inc

How to do anything on your Mac, iPhone & iPad

X~

Composer - 1??0—1'82?
Ludwig van
Beethoven

B Choose a composer

In Browse > Catalog, tap
Composers to reveal a list of classical
composers. Tap any one of these to reveal
a page for that composer with an Editor’'s
Choice, collections of Popular Works, and
even an artist biography.

moderato

W, Lossless

<« |I

e )

>

) @ =

More play controls

While a track is playing, tap the
mini player at the bottom of the screen to
reveal the full-screen player. From here
you can access playback controls, adjust
the volume, find out more info (tap the “i").
or send the track to an AirPlay speaker.

Q, abeethoven triple concertd €@ Cancel

Albums

Beethoven: Triple Concerto;
Overtures
Yo-Yo Ma, Berlin Philharmonic, Ma...

Beethoven: Triple Concerto &
Symphony No. 7 (Live)

Daniel Barenboim, Yo-Yo Ma, Anne...

=1 Reethoven: Trinla Concarta &

Go find something
Now tap the Search button, then
type a search term in the field at the top.
You can be quite specific in your search
— for example, you can choose an artist, a
composer, a work, and even a movement
all at the same time. Clever stuff.

€ Browse

Curated by Artists

4]
Yo-Yo Ma: Our Common Nature
Apple Music Classical
Isata Kanneh-Mason: Music for
Midnight
Apple Music Classical

[} E
I- M | Joshua Bell: Life-Chanaers

o Choose a playlist

Next, tap Browse > Playlists.
Here you'll see playlists arranged by the
likes of Composer, Artist, and Mood. Tap
Curated by Artists to see playlists that
have been specially created by classical
artists such as Lang Lang and Yo-Yo Ma.

Ucells Pau Lasais
Intimo: El Cant del Oc...

Playing Next =

Lalo: Symphonie espagnole, Op. 21

lll. Intermezzo. Allegretto non troppo
Ny
Eugene Ormandy

C. Shaw: To the Sky

#* 1o the Sky

i Cargiine shaw

What's playing next?

Tap the “list” button on the right
of the playback controls to see what's
playing next. While you can't delete or
reorder tracks (like you can in the Apple
Music app), tapping another track will
start that one playing instead.

Recently Played >

HARNONCOURT

D —

Beethoven: Symphoni... Mozart: The Complet...
. Nikolaus Harnoncourt... Daniel Barenboim & E...

Meanwhile...

One slightly odd element about
Apple Music Classical is that it shares any
tracks you've added to its library with your
regular Apple Music library too. Hopefully
an option to choose not to do that will
appear in due course.
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Apple

watchOS 10 Described as Apple Watch's Biggest Software Uipdate Since 2018

Apple will lay sidetoading groundwerk in 105 17

Make Reddit easier to use

See the most fun social network in a whole new way with Apollo

REQUIRES
Apollo (Free, offers IAPs),
iPad0S 15 or later

YOU WILL LEARN
How to join and view
Reddit in Apollo

IT WILL TAKE
15 minutes

=

GENIUS TIP

If you're searching

for unbiased product
reviews on Google, add
“reddit” to your search
criteria to see what actual
customers have to say.

32 | AUG 2023

REDDIT IS THE 10th most-visited
website in the world. Whether
you’re looking for Logic Pro tips,
air fryer advice or funny photos
of dogs, there’s a subreddit about it.

But that sheer sprawl can make the main
website intimidating. That’s where Apollo
comes in. It’s designed for iOS, iPadOS and
macOS, and it’s here to make Reddit
simpler and easier to use.

The little trophy icon at the top-right enables you to sort
comments by date, popularity, or how controversial they are.

In this tutorial, we’re going to use the
free version of Apollo on iPad because that
makes for the clearest screenshots, but it’s
actually best-suited to your iPhone where it
doesn’t have quite so much white space; the
developers admit that the iPad version is
“awork in progress”.

It’s easy to find and view all kinds of
content, reply to others, change the way the
app works and sort what you see, but there’s
one thing that Apollo’s free version doesn’t
let you do — post new topics. That’s reserved
for the Ultra version ($1.49/month), which
also adds the ability to use multiple Reddit
accounts from the same app.

PLENTY TO SEE

That doesn’t mean the free version is
severely limited, though. It contains an
excellent media viewer for images and
videos, shows previews of links inside
comment threads, uses Markdown in
comment writing, and supports Dark Mode
too. If you’ve ever wanted to use Reddit but
been put off by its Wild West feel, Apollo
will make everything much more
welcoming. CARRIE MARSHALL

Image rights: Apple Inc, Christian Selig
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HOW TO Join and use Reddit in Apollo

Signin or up

If you already have a Reddit
account, sign in here and Apollo will bring
in your current subscriptions, messages.
and settings. If you're new to Reddit, tap
on the Create Account link and you'll be
taken step-by-step through the process.

Adjust the options

If you tap on the “." options icon
at the top-right of the screen you'll see
a selection of options such as hiding
posts you've already read, showing posts
in a more compact view, viewing the
subreddit’s rules, and so on.
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Make it yours

If you get bitten by the Reddit bug,

these features give lots of personalization
power. There are lots of options, ranging
from whether videos should unmute on
playback to which apps links should open
in and videos should play in.

Image rights: Apple Inc, Christian Selig.
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Pick your topic

Tap on Posts to choose from three
options: Home, for posts from subreddits
(topic-specific posting areas) you've
subscribed to; Popular Posts (what's
currently trending); or All Posts. Tap on the
“+" button to find specific subreddits.

& T | @

Read the cha

Reddit shows comments on its
posts, which you'll see when you click on
a post title. Here you can read what other
people are saying, and you can also tap on
the “." icon next to a comment to upvote
(like) or downvote (dislike) it.

" & i o

Place your hands

Apollo also features gesture
support, which works on touchscreens
and trackpads alike. In the free version
you can't customize which gestures do
what, but the presets are all pretty
straightforward and useful.

- & - o - ]

See your selection

In this example, we've searched for
greyhounds, which takes us straight to the
r/greyhounds subreddit. As you can see,
it's simple — posts appear in an infinite
scrolling window and you just click on the
ones you want to read in full.
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Get the look

Apollo enables you to change
the appearance in many different ways,
including applying new color themes,
changing text size, reducing or increasing
the size of posts, and showing or hiding
icons and usernames.

Upgrade to Ultra

The free version is packed with
features, but the Ultra version offers
more including the ability to protect your
account with Touch ID or a passcode,
multiple account handling, customizable
gestures, and custom app icons.
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Learn a foreign
language
through song

Lirica uses pop songs to
teach European languages

REQUIRES
Lirica (Free, offers IAPs),
i0S 1 or later

YOU WILL LEARN
A European foreign
language via major

pop songs

IT WILL TAKE
5-10 minutes

34 | AUG 2023

French Hip Hop/
R&B

Feel the love

WE'VE ALL HAD those moments

when an international song has

got stuck in our heads. Ever

thought how that could help
improve your foreign language skills? The
team behind the Lirica app has. Lirica aims
to teach you French, German, Spanish (and
English) using the power of song. Don’t
worry, though, you do not need to be
particularly musical to benefit!

Technically, we should write "ils ne
veulent pas", but we often drop the
"ne" in spoken French!

As well as being a catchy way to learn how to speak another
language, Lirica also offers tips for writing in it too.

In your feels

> - i ‘ (?:‘
French Pop

onths of the year

Lirica is easy to use. Pick the language you
want to learn, and you’re guided through
every stage. To start, you listen to a song,
read the lyrics, and learn key phrases by
tapping on them. After that, the app tests
you through a variety of challenges. Each
one of these gets a little more difficult as
you build up your skills. It’s not just about
learning vocabulary and grammar either,
there are audio tests too, so users learn how
to pronounce words and phrases accurately.

LEARNING VIA SONG

You can change what language you are being
taught at any point — so, if you’re feeling
adventurous, you can brush up your skills in
any of the languages that the app offers at
the same time. If one of the levels is too
easy, you can up the difficulty. Lirica is free,
but some songs, lessons, and features
require a subscription. A one-year Premium
subscription costs $29.99 (there’s a seven-
day free trial). There are also one-, three-
and six—-month options. CHARLOTTE HENRY
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HOW TO Use Lirica to learn a language

Pick your language

When the app is first opened, you are
asked to pick which language you would like to
try first. This can be changed at any time. You
also clarify your native language so the lesson
is the right language for you to learn in.

>

Play video

Watch the music video
With the lesson open, tap Play Video to
watch and listen to the music video you will be
tested on. You can watch the video as many
times as you like to get used to the lyrics.. or
if you are enjoying it!

Verse 2

gu'un jour tu me
déclareras ta flamme

Learn from your mistakes
We can't all get it right first time so any
mistakes are highlighted in red. The app shows
the correct answer, but you lose a heart — you
have three for each challenge. Don't worry,
you can always try again to improve your score.

Image rights: Apple Inc, Taplyrica Ltd

n French

Start your first lesson

To start the first lesson, click on its title
(top of the page). This example is “l am French.”
As you progress, Lirica tells you what to expect
from each lesson. For now, open up your first
song and get used to how things work.

1.vocab challenge

o Time for a challenge

Once acquainted with the song, it's
time to take your first challenge. Tap “1. vocab
challenge” to begin. The app helps you through,
firstly by tapping on the words highlighted in blue.
You are then tested on these key words.

) Keep going!

" There are various types of tasks available.
When you have finished one challenge, move

on to the next. Once you've completed all the
challenges for one song, go back to the Learn
tab and start a new one.

53]

JARGON BUSTER

The Awards tab enables
you to keep track of your
progress, including how
many words you've learned,
and any achievements the
app gives you.

=

GENIUS TIP

The Play tab has a library
of songs and challenges.
You can share these with
friends and family by
tapping on a song and
then the share icon on
the right-hand side.
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Get started with Agenda

Plan, keep track, and make notes in the same app with Agenda

REQUIRES
Agenda (Free, offers IAPs),
iPad0S 13 or later

YOU WILL LEARN
How to use Agenda for iPad
to make date-focused notes

IT WILL TAKE
30 minutes

THERE'S NO SHORTAGE of
note—taking apps for iPad,
iPhone, and Mac. And there are
plenty that sync on all three
devices. But there were good reasons why
Agenda: Notes Meets Calendar came top in
our recent group test...

It’s the only note-taking app that uses
the date as a focus. That turns Agenda into
a powerful tool for planning projects on
your own or with others, for making notes
and referring to them later, or collecting
recipes from websites and assigning dates
to try them.

QUICK LOOK The Agenda interface

Agenda uses colored tags to make it
easy to find notes, and the app is deeply
integrated with Apple’s way of doing things
so has Share extensions, Widgets, and
Shortcut actions. It also syncs with Calendar
and Reminders, so you can see entries
alongside your notes.

Notes can contain images and URLs,
and formatted text. Notes are organized in
projects, but the real star of the show is the
“On the Agenda” view which allows you to
quickly see what you should be focused on.

Everything we cover here can be done
with the free version. KENNY HEMPHILL

15:56 Fri 1 Apr

On the Agenda o

Travel Cruise 2023

™% Today
To do before departure
A Searcn Al Notes from Calendar Event
1 Bin O Book cab to Airport ([FEEE]
O Pack (Packing List}
O Book excursions
The Island O Research stop-off paints
71 I's nothing
Ve ol rrvart anel A e tres What | want to do on holiday
b Fiction ideas Explore the stop-offs

1

2
sl p 3. Party!

4. Eat d foad
= Cruise 202 ol itaiios

[F] Mac Security guide

ON THE AGENDA
On the Agenda enables you to
more easily focus on the most

pressing items that are on your

to-do list.
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[[F] MacFormat features

=] MacFormat Tutorials
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Relax

Itinerary

D &
PROJECTS CALENDAR
Your projects are listed in the
sidebar and can be grouped.
Tapping on a project displays
its notes.

from the right.

Calendar entries and Reminders are
hidden by default, but can slide out

[ Joly 2028 o +

Flight to Barcelona...

Sun 30 B

Leave Barcelona for Toulon

Mon 31

1B MYP English ¥r1

Tue 1 August

f100 | & . ;
Business Goals - no inter...

&, Recently Edited
‘What | want to do on haoliday

To do before departure

@ Related Notes

IMAGES

Notes can have thumbnail
images, but full-width versions
are a premium feature.

Image rights: Apple Inc, Momenta BV.
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HOW TO Get started with Agenda for iPad

%;_
§

Create a project

Tap the “+" at the bottom left of
the screen, then tap New Category. Give
this category a name and a color. The
category will appear with Untitled next
to it. Touch and hold Untitled, then type
a new name for the category in the box.

Rirera—

Today Packing List

B Mark a5 On the Agenda

e
P PintoTop ek adap

E Cruise 2023
Make into Footnote

Add to your agenda

To make a note appearin On the
Agenda, tap it then tap the dot at the top
left corner and choose Mark as On the

Agenda. If the dot is filled with orange, the
note is already on the agenda. You can
remove it the same way.

Insert a link

You can insert links to other
notes, or to anywhere on the web. Tap
inside the note where you want to add
the link, then tap the “+" in the keyboard
toolbar. Tap the link icon, then choose
Add Web Link or tap on a note.

Image rights: Apple Inc, Momenta BV.

o Uinasted Msen

as A
Create a new note

When you create a project, it
already has an empty note in it. Tap and
hold on Untitled Note and rename it. To
create a new note thereafter, tap the “+"
at the top right of the screen and replace
Untitled Note with a name.

Home Lists: +icay pscing st -9
Move hote Tac

Haliday packing it Ot Project n
Tt oot
Fip Sopa
Shidey The istard
Chargers S W neihing
Ea——

LIS —
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Pad Foction ideas.
Kindtu

WMowias watchad in lockdown T ez
Tha Vit of hoght
A

- 7 machorma fnaturms

You can move a noteto a
different project or to a new project. Tap
the note then the gearicon at the bottom
right and choose Move To. Scroll down to
the project you want and tap it, or scroll
to the bottom and tap New Project.

e R
-

o o

Add an image

To add an image to a note on
iPad, it needs to be in your Photos
Library. Tap the “+" in the toolbar, then
tap the flower icon. Navigate or search
in the Photos window that opens, then
tap the photo you want to add.

July 2023 Calenclar Events +
~ T T F 519
L | Fight o Baremos Kzt
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v o® ow owmon 2 on e
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B T 1 et
hange i 25 iy 3023 &
B e e ]
B Assign a date
to anote

Tap on a note then the calendar icon at
the top right of the note. A window with a
calendar in it will open. Go to the date you
want and tap it. Tap Assign Date to make
the note appear in Today on that day.

S
Write a note

To start writing in a note, tap the
project in the sidebar, then tap in the
note. It will open and you can now start
typing. You'll see formatting tools along
the top of the keyboard. Just select text
and tap a tool to format that text.

RO ————

P
£ ey
<
“Hinerary”

Share 1z note with athers

a

Stucess: [0

vteto: S0

Share a note

In the note you want to share,
tap the head-and-shoulders icon at the
top right. In the “Invite to” menu, choose
Share Note. Then Tap Share Note at the
bottom. Choose how you want to share
it, or Copy to copy a link to it.
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Just Eat

MEATER

Monzo

Notes

Shazam

Things

Uber

WhatsApp

Wiz

Notifications Yodel

Indicator

Messenger

Master @ Watch notifications

REQUIRES
watchOS 8 or later

YOU WILL LEARN
How to control notifications
on your Apple Watch

IT WILL TAKE
10 minutes

-

GENIUS TIP

If a notification interrupts
you but you don't want to
silence it forever, tap on
the “..." icon and select
Mute For 1Hour, or

Mute For Today.

38 | AUG 2023

MANY OF US have a love/hate
relationship with notifications
on Apple Watch. We love them

because they ensure we never

miss messages from our friends and family,
and because they’re really useful when
we’re using an app such as Maps. And we
hate them because it seems that every app
we put on our iPhone wants to notify us of

ALLOW NOTIFICATIONS

People
1O
Auto-Reply

CUSTOMISE SCREENS

09:41

Don't forget about combining these tips with Focus
modes (Settings > Focus on your iPhone); they can
limit notifications to specific apps or people.

everything everywhere all of the time,
usually at the worst possible moment. So
it’s a good job Apple makes it easy to control
notifications in lots of different ways.

As you’ll discover, the control you have
varies from app to app — so, for example, in
Calendar you don’t just have a yes/no choice
for notifications. You also have the ability to
silence all notifications apart from new
invitations or changes to shared calendars.
Similarly in the Mail app you can limit
notifications to specific accounts so you
don’t get updates about work emails when
you’re chilling out at home, and so on.

You can also make some notifications
more important than others, such as
ensuring your Watch notifies you of health-
related events or if you’re somewhere that
could lead to damage to your hearing. In
addition, you can also use Focus modes
specified from your iPhone. These enable
you to organize your notifications in each
mode — for example, you might want
different notification settings when you’re
at home or at the gym. CARRIE MARSHALL



Control Apple Watch notifications

MNotifications
Indicator

\ Enter Settings
Y Gointo Settings > Notifications
on your Apple Watch to change how
notifications work on your wrist. The first
option is whether your Watch should
display a red dot at the top of the current
face to let you know of new notifications.

Haptic Alerts
Default

Prominent

)\ Feel the news
> Goto Settings > Sounds & Haptics.
By default, your Apple Watch will give you
a little vibration whenever there's a new
notification. You can turn that off here,
or turn it up; selecting Prominent makes
the vibration alerts stronger.

Enviranmental Sound Meast

Moise Threshold

Bring the noise

With health-related apps, you'll ind
more detailed settings when you tap on
them. In the Noise app, you can adjust the
noise threshold so that you're notified if
the sound around you is louder than the
level you specify — here, 95 decibels.

10:11

Tap to Show Full
Notification

Show Notifications on
Wrist Down

, Ask for more

. " If you scroll down the Notifications
page, you'll see these options. These
enable you to show a tappable summary
of a new notification or to display
notifications even if your Apple Watch
doesn't think you're currently looking.

Notifications
Activity
App Store
Audiobooks
Calendar

CARROT

, Adjust every app

“ You don't have to have the same
settings for every app. If you go into the
Watch app on your iPhone and select
Notifications, you'll see a list of all the apps
on your Watch — first the Apple ones, and
then third-party ones.

Cardio Fitness Notifications

Irregular Rhythm

) Have a heart

" The Heart Health settings are even
more personal, enabling you to set cardio
fitness options such as the level beyond
which your Watch will warn of high or low
heart rates, whether it should notify you of
irregular heart rhythms, and more.

10:11

Announce Notifications

Make Siri speak

S When you're wearing headphones,
you can get Siri to tell you about new
notifications. With AirPods, AirPods Pro

or AirPods Max, Siri will then wait for

you to respond, so you don't have to

say “Hey, Siri" first.

Messages

Mirror my iPhone

Custom

Allow Notif

Change the settings
S Mirror My iPhone is the default for
most apps, but you can override that. For
example, here you can adjust how many
repeat alerts Messages gives you, and
whether you should get an audible alert,
a haptic one, neither, or both.

Notifications

Hive
Home
Instagram

Just Eat

A Eliminate

&7 annoyances

If you've ever installed an app only to
be constantly interrupted by unwanted
notifications, you can control that here.
Tap on the toggle next to the app from
which you want to silence notifications.
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IP ratings

The IP rating is a crucial piece of information for any outdoor device

YOU WILL LEARN
What IP ratings mean, and
how they can help you to
protect your digital devices

(3]

JARGON BUSTER
The second digit in

an IP rating refers to
protection against
water — but it doesn't
cover other liquids, such
as acids, which can
corrode many electrical
components. Humidity
and salt can be a
problem too — salty sea
air can be a real killer
for all sorts of digital
devices. That's where
the MIL-STD standard
comes in (see Tough
tech to the right).
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EVERY NEW TECHNOLOGY has its
own assortment of jargon and
technical terms that we all have
to try to learn and understand.
Computers have CPUs and GPUs,
headphones have “decibels” and “frequency
response,” and Wi-Fi routers have truly
mind-boggling jargon like “orthogonal
frequency division multiple access”
— which is kind of the Wi-Fi equivalent
of “everything, everywhere, all at once.”
However, the term “IP” is one that cuts
right across different product categories and
technologies, and can be applied to a wide
range of different devices. In fact, those two
letters — IP — actually have multiple
meanings, ranging from Internet Protocol
to the Intellectual Property involved in so

> TOUGH TECH

many legal battles these days. However,
the version of IP that we’re looking at here
refers to Ingress Protection, and it’s a term
that applies to everything from hard drives
to headphones, smartphones, and even
“ruggedized” laptops that are designed for
outdoor use.

Ingress Protection refers to the casing, or
enclosure, of any electrical device, and how
well it protects against water and dust, or
other small particles, that might penetrate
the device and damage its internal electrical
components. Manufacturers of electronic
devices will often say that their products are
“waterproof” or “dust-proof,” but those
terms are pretty vague.

After all, your waterproof AirPods may be
able to cope with a spot of rain or sweat

There's another rating standard that is often used when talking about “ruggedized”
technology, such as laptops, smartphones and hard drives that are designed for use

in harsh conditions. It's known as MIL-STD-810 (although manufacturers often just
shorten it to MIL-STD) to imply “military standard” ruggedness. This includes protection
against harsh climates with high or low temperatures, high humidity, or corrosive salt.

It can also indicate shock or pressure resistance — being run over by a car, for example
— but manufacturers can be quite vague with their use of this term, so always check the
details when any product is described as providing MIL-STD protection.

Image rights: Apple Inc.



FIRST DIGIT — PROTECTION AGAINST

DUST/SOLID PARTICLES

(0  Noprotection

1 Protects against particles/objects larger than 50mm

2 Protects against particles/objects larger than

12.5mm (ie, fingertips)

3 2.5mm (ie, tools, wires)

4 Protects against particles/objects larger than 1mm
(ie, wires, screws)

5 Dust-protected — some particles may enter, but
won't damage the device

6 Dust-tight — complete protection against dust and

other particles for up to eight hours

when you’re jogging around your local park,
but they probably won’t survive being
dropped into the deep end of a swimming
pool. However, an IP rating gives you

a precise numerical value that indicates
how well your new earbuds, hard drive, or
other devices will cope when they’re
exposed to the elements.

DOUBLE DIGITS
The IP rating gives you two numerical values
that you need to know about. The iPhone 14
has a rating of IP68, with the first digit - the
6 - indicating the level of protection against
solid particles such as dust, dirt, or sand.
The second digit — the 8 — indicates
protection against water, and this is what
manufacturers refer to when they say
that a product is “waterproof.” In both
cases, a rating of 0 (zero) indicates no
protection at all. Sometimes, though,
manufacturers will use an “X” instead,
which means that the device hasn’t been
tested for that particular type of protection.
For instance, the AirPods Pro are rated
IPX4, which means that they haven’t been
tested for protection against dust (the first
digit). However, they do provide level 4
protection against water (the second digit),
which means that they’re “splash resistant”
but can’t survive total immersion in water.

Image rights: Apple Inc

Protects against particles/objects larger than

How to do anything on your Mac, iPhone & iPad

No protection

0 N OO0 O A W N = O

3m depth)

Protection against dust and solid particles
goes from 0 (zero protection) to a maximum
score of 6, which means the device is sealed
“dust-tight” and can prevent any particles,
such as dust on a construction site or sand
on a beach, getting into the device for up to
eight hours. The second digit, for water
protection, goes all the way up to 9, which
indicates complete protection against
both very high water pressure and high-
temperature water too. Very few devices
score “9” for water protection, but many
devices, particularly smartphones, provide
a rating of 8, which means they can survive
complete immersion in water to a depth of
up to 3m. The iPhone 12, 13, and 14 are all
rated IP68, which means that they are dust-
tight and can survive total immersion in
water. And, in fact, these models go beyond
the standard 8 rating for water protection,
as Apple states that they can survive under
water in depths of up to 6m too.

We’ve focused on Apple devices here,
such as AirPods and the iPhone, but
remember that IP ratings can apply to a wide
range of different devices. Always look out
for the IP rating whenever you buy other
devices, such as hard drives or solid—state
drives (SSDs), or even keyboards and mice,
that are designed for use in harsh
environments. CLIFF JOSEPH

SECOND DIGIT — WATER PROTECTION

Protects against vertically dripping water (ie, rain)

Protects against water dripping at an angle of 150°

Protects against water spraying (10 litres per min)

Protects against water splashing/spraying
Protects against water jets (12.5 litres per min)
Protects against strong water jets (100 litres per min)

Protects against immersion in water (up to 1m depth)

Protects against immersion in water (up to

KEY FACT

The IP rating system

is officially known as
International Standard
EN 60529, and is defined
by the International
Electrotechnical
Commission (IEC). Based
in Switzerland, the IEC
works with more than
170 countries to establish
international standards
for electronic devices.

AUG 2023 | 41



aASK

EXPERT
ADVICE

Our resident genius
Howard Oakley solves
your Mac and i0S problems

TECH SUPPORT & TECHSPLANATIONS

Version numbering changes

WHEN APPLE RELEASED
9 Big Sur in 2020 it took us

by surprise, changing
macOS version numbering from
the chaos of “10.14.6 Supplemental
Update 2” to a rational system of
three numbers. When your Mac
is running 13.3.1 you know it’s the
first patch of minor version 3 of

major release 13, whereas that
version of Mojave was really the
third “Supplemental Update” not
the second.

Then came the first Rapid
Security Response to shatter the
peace with its appended letter in
parentheses, taking 13.3.1t0 13.3.1
(@). Software expecting to see just

> Remove an RSR update

After installing a Rapid Security Response (RSR) for Ventura, Safari won’t connect
to some of my key websites. How can | remove that RSR?

numbers and full stops broke
immediately, and those wondering
how yet another version
numbering system works have
been left baffled.

Don’t even try to make sense of
the build number, with three extra
digits and the letter a, to go from
22E261 to 22E772610a.

RSRs are hot fixes that aren't as thoroughly
tested as regular macOS updates, so do
carry a risk that they could cause problems
for some. To counter that, Apple makes
them easily uninstallable.

Before deciding that's your best solution,
see if you can settle those problems. If your
Mac hasn't started up since installing the
RSR, restart it, as that can make some
issues vanish. If they persist, start your Mac
up in Safe mode, leave it running for a
couple of minutes, then restart back into
normal mode.

If after trying those the problems
remain sufficiently obstructive that
you still want to remove the RSR,
open System Settings > General > About
and locate the box giving the macOS
version, which now has a letter after the
version number. Click on the Info tool to the
right of that number, and in the dialog click
on the Remove & Restart button. Your Mac
should then revert to its former self, with
the whole of that RSR removed, once it
has restarted.

As the fixes provided in RSRs will be
incorporated into the next macOS update,
be extra vigilant until Apple releases that
and it's installed on your Mac.
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< About

Last Rap

macOs

id Security Response

macOS Ventura 13.3.1 (a) (22E772610a)

This Rapid Security Response provides important security fixes and is
recommended for all users.

To learn more, please visit https://fsupport.apple.com/HT201224

emove & Restart
Remove & Restart Book Pro

Spple M1 |
Last macOS Update
macOS Ventura 13.3.1 (22E261)

macOS Ventura 13.3.1 provides important bug fixes and security updates
for your Mac, including:

. n)

Pushing hands emaoji does not show skin tone variations
Auto Unlock your Mac with Apple Watch may not work

For detailed information about the security content of this update,
please visit: https://support.apple.com/kb/HT201222

Done

| Buiit-in Liquid Retina XDR Display 16-inch (34

Removing an RSR is made straightforward in this pane in System Settings > General > About,
but first ensure it's the only solution.

Image rights: Apple Inc



>Unscramble
and share
Wi-Fi
passwords

The saved Wi-Fi
passwords on

my iPhone got
muddled when
updating to i0S 16.4.1.
How can | set them
right and then share
them with others?

Apple devices manage their
Wi-Fi passwords separately
from those used in Safari as
shown in Settings >
Passwords, and normally hide
those for networks the device
can't currently see. To view
and manage all those your
device has remembered,
open Settings > Wi-Fi then
tap Edit at the top right; that
requires either Face ID or
Touch ID. If you share your
keychain in iCloud, that list
should give access to

those known to other devices
and Macs that are sharing
that keychain.

Recent versions of iOS and
iPadOS offer a neat way to
share the password of the
Wi-Fi network your device is
currently connected to,
provided both are signed in to
iCloud, have one another’s
Apple ID email addresses
saved in Contacts, have
Bluetooth turned on, and

Image rights: Apple Inc

19:49

{ Settings

Wi-Fi Password

Allow Others to Join

Personal Hotspot

Tap an obscured password to reveal it and the command to copy it.

Personal Hotspot disabled.
This is explained at
https://apple.co/3r4ZFS

Alternatively, you may find
it a simpler process just to
send the password to
someone using Messages.
Open the network settings,
either for a network available
locally, or one on the list of all
networks. Tap on the
obscured password to reveal
the Copy command,

then switch to Messages and
paste it in your message
there. Once the recipient

has inserted that password,
you should both then delete
that message for security.

If your devices share their
keychain with a Mac, you can
use Keychain Access from
Applications > Utilities to look
for AirPort Network
Passwords and manage and
edit them there.

Tech Support & Techsplanations

Quick-fire
questions
& answers

HOW TO UNINSTALL
A TROUBLESOME
SECURITY
RESPONSE?

Firstly, shut your iPhone
down, leave it a minute,
and startit up again, in
case that fixes things.
To remove the RSR, go
to Settings > General >
About >i0S Version,
and tap Remove
Security Response.
Once it's gone, your
iPhone should restart
automatically.

HOW TO SHARE MY
iPHONE'S HOTSPOT
WITH MY FAMILY?
This is controlled notin
Settings > Family, but
through Personal
Hotspot > Family
Sharing instead. It only
applies to those in your
iCloud Family, and gives
you the option for each
share request to
reqguire your approval,
or simply to share the
hotspot with them
automatically, without
them having to enter
the hotspot password
each time.

Aliow Others to Join

Wi-Fi Password
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https://apple.co/3r4ZFSY

Quick-fire
questions
& answers

WHICH EXTERNAL
GPUS WORK

WITH APPLE
SILICON MACS?
None, because its GPU
is integrated into the
chip, where it shares
Unified Memory with
the processor. As an
eGPU can't share that
memory, Apple would
need to designin
support for that. Even
with Intel Macs, there
are limits to support
detailed at https:7/]
[apple.co/3NtoBL1

CAN | UPGRADE MY
MAC STUDIO M1 MAX
TO M1ULTRA?

Apple shows no sign of
offering such hardware
upgrades. With the
introduction of self-
repair in many
countries, it could be
possible to order a
replacement Ultra logic
board and fit it yourself.
However, parts are
ordered against the
Mac's serial number, so
cheating doesn’t look
possible, and would be
expensive and difficult.
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Mac Hardware

We're here to help solve your hardware hassles

> Prepare an internal drive for recycling

How should a friend dispose of his old iMac, to ensure that there’s no
data available from it when it goes for recycling?

Before he starts cleaning its internal storage,
there’s a list of essential tasks to work through
once that Mac has been thoroughly backed up
and its contents preserved reliably. Apple
silicon Macs and those with T2 chips can do
those quickly and cleanly using the “Erase All
Content and Settings” feature that's found in
System Settings > General > Transfer or Reset,
but they have to be performed manually on
older models.

First disable Find My Mac and Activation
Lock, and deauthorize it for iTunes. Next sign
out of iCloud and iMessage. Disable any
firmware password, reset the NVRAM, unpair
all Bluetooth devices, and finally remove that
Mac from the list of hardware in the Apple ID

Disk Utility

pane on the owner’s other Mac, or its
equivalent in a device’s Settings. Those
steps are detailed at https://bit.ly/3Pwk3Gl
Once those have been done, an internal
hard drive should be securely erased using
Disk Utility in Recovery mode, or when started
up from an external drive. It's normally only
necessary to use either of the two faster
options for that. Unfortunately, SSDs aren't
suitable for that and should just be erased
normally. Then shut the Mac down, disconnect
it from all power, and open it up to remove its
internal storage. Physically destroy that using
a hefty hammer, nail, drill, or whatever. They
can prove quite tough, butit's a wonderful
feeling and well worth the effort.

I Samsung SSD 990 PRO 2TB Media

"
8 Erase "Samsung SSD 990 PRO 2TB Media"?
% Erasing "Samsung SSD 990 PRO 2TB Media" will permanently erase all
data stored on it. You can't undo this action.
La -
Name: | Untitled
Ce
Format: APFS 3
4 Scheme: GUID Partition Map &
Sh
Cancel Erase

Try to erase an SSD and Disk Utility won't offer any Secure Erase options, as they're only available for hard disks.

Image rights: Apple Inc
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Diagnostics Loader

Downloading Diagnostics...

> Diagnose a flashing display

The display of my M1 MacBook Pro 13-inch has begun flashing during
startup, but then works fine. How can | tell whether it's faulty?

Quick-fire
questions
& answers

WHICH APPLE
POWER ADAPTORS
WORK WITH MACS?
Check out https:7]
lapple.co/3JzA9vD. You
can interchange recent
USB-C adaptors,
picking the newest
when available.

With their integrated graphics processing,
Apple silicon Macs are less prone to hardware
problems than older Macs with separate
graphics cards. Test this using Diagnostics
from Recovery mode.

Ensure your Mac has a good Wi-Fi
connection, as it may need to download the
diagnostics software from Apple, then shut
it down. When you press its Power button
to start it up, keep pressing until it shows its
loading Options. Once that has loaded, press

> Fusion Drive reports errors

The Fusion Drive in my iMac keeps throwing errors, as if it's about to fail.
Can | split it and carry on using its SSD, or should | get it replaced?

MagSafe is more
complicated, as
versions 1and 2 can be
interchanged using an
adaptor, but not

and hold Cmd+D until you're told that
Diagnostics is loading, then select your
language for the loader app to run and
offer Diagnostics.

Once it has finished, you'll get a code you MagSafe 3.
can look up. You could also run extended
diagnostics by pressing Cmd+E, but that's DO MACS CHECK
undocumented and may not provide different THEIR MEMORY
tests. If those fail to find a hardware problem, WHEN THEY
then it's most probable this is just a quirk of POWER UP?

the startup process. Yes, all Macs complete a
power-on self test
(POST) before starting
to boot, although only
Intel models report
results of the testin
System Information,

in Diagnostics under

Hardware. If you

When you suspect a Mac's internal storage
might be failing, keep good backups without
putting any more stress on the drive. While
macO0S Diagnostics and third-party disk
health apps could provide more details,
errors are a good reason for taking early
action to replace any Fusion Drive before

it gives up the ghost.

Fusion Drives consist of a smaller SSD
alongside a larger hard disk, held together
using Core Storage software. Splitting them
can only be performed using the diskutil
command in Terminal, and destroys all the
data on both of them. As the SSD is also likely
to be showing signs of age, it's normally
better to have them both replaced, ideally
with a new SSD if you can afford it. In most
Macs that involves plenty of tricky

suspecta memory
problem, running
full Diagnostics is
more thorough.

disassembly and is best left to
an experienced technician.

As your iMac doesn’'t have a T2 chip,
another option is to replace the Fusion
Drive with a
small hard drive
just for
emergencies,
and to start up
and run your
Mac from an
external SSD,
which is still
likely to
perform better
than its original
internal
storage.

(] MacBack Pro

It's best to replace the whole of a Fusion Drive when it looks
as if it might be about to fail.
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@ Ask

@ mac0S

Shine a spotlight on the solutions to
your most irritating Mac problems

> Put fonts into a family

| tried to install two font families, but they appear in Font Book as
individual fonts instead. How can | turn them into the families | want?

For a group of fonts to be recognized by ~ Try FontLab’s TransType from .

macOS as a family, they need to be [Attps://bit.ly/3phh368] for $97 — it B (A &aAi bk kX
structured and installed as one, does have a trial period, so you should AAAAARAARAALRRBR KR
although normally spread across be able to test the app out first. The way A A SO Eae a6
multiple files. If Font Book doesn't that it builds individual fonts into el

recognize them as a family, then all it families is explained in full at F 6 6 & 6 &

can do is put them into a collection, |https://bit.ly/3Pz3vhK. oo 1 s

which works differently. Key to any font Once you've made the families, 11121 fer

family is its common typographic name, uninstall the existing single fonts and : : : : : .

and within each family, individual style install the families. To rebuild font M NNOG:

names. If those fonts haven't comeasa  caches, start your Mac up in Safe mode, o iy o
family, then you will need a proper font leave it a couple of minutes, then Font Book can't assemble individual fonts into a
editor in order to build them into one. restart it into normal mode. family. You'll need one of FontLab's font editors.

> Deduplication may not free space

I've tried using various apps to find and remove duplicate files,
but they seldom seem to free up much space as a result. Why not?

The success of what's known as deduplication depends When you first check a drive that's come from an
on whether the files are actually copies of one another, older Mac and wasn’t used much in APFS, deduplicators
or are clones. Before Apple File System (APFS) arrived can save significant amounts of space. But the more
in High Sierra, such clone files didn't exist in macOS: that drive has been used in APFS format, the more
when you duplicated or copied any file, a copy of the duplicates will be clones, and the quantity recovered
original was made, meaning that twice the disk space falls until the procedure is no longer worthwhile.
was required.
APFS now tries to make a clone file whenever it can,
although that can't work across different volumes.
Instead of two clone files occupying twice the space of
one, they share the same data at first, so take no
additional space at all. As they're changed, they take up
more storage until they eventually become completely
separate and require their full size.
Because of this, if a third-party utility removes one
of a pair of clone files, no disk space is recovered. Some
replace a pair of identical files with clones, but if the Tiiemiie, A :
originals were already cloned, that doesn’t change the Although the Finder claims this folder of APFS clone files takes 506B,
amount of space they occupy either. it takes no space at all, as they share data.
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Tech Support & Techsplanations

EMAIL:[zsk@maclife.com
FACEBOOK:[facebook.com/maclite] TWITTER:[fwitter.com/maclitel
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How much space is really free?

My M1 Mac mini is running short of internal storage. With free space
at a premium, the Finder and Disk Utility often differ on what
they claim is available. Which should | believe?

If you need to know accurate figures for free or
used disk space, trust those provided by Disk
Utility, not the Finder, because of the way they
obtain them. Select any disk or volume in Disk
Utility, and the app gets a fresh estimate from
macOS for each of the figures it displays.

The Finder, on the other hand, merely
tells you the last figures it was updated with,
which could be from ten or more minutes ago,
and there’s no way you can force it to update
them with more recent info.

The figures themselves aren’t as
straightforward as they appear: what's shown
as Available isn't actually free at that moment,
but what macOS could make available if it

really needed to. To achieve that, it would need

to free all that is shown as being Purgeable,
largely by clearing out hidden caches. That
can sometimes include space being used for
the storage of data for snapshots, but doesn't
normally include what could be freed by
evicting iCloud files and data from local
storage, which macOS can do if Optimize
Storage is enabled in iCloud settings.

A more reliable estimate of the minimum
free space available is given as Free Space
when you select a volume and click on the
Info tool in Disk Utility, as that doesn't include
Purgeable space, so is usually significantly
less than that given as Available.

Quick-fire
questions
& answers

WHY HAS EFICHECK
STOPPED WORKING
IN MACOS VENTURA?
eficheck should still
run its silent weekly
check on the integrity
of your Mac's firmware,
but because of
security changes in
mac0S 13, it may not
work when you run

a checkin Terminal
yourself. This should be
fixed in the macOS
13.5 update.

DOES SAFE MODE
CHECK THE BOOT
DISK FOR ERRORS?
According to Apple it
runs a quick check of
volumes in the current
boot volume group,
although it doesn't
report the result
anywhere accessible,
and doesn't check
snapshots. You'e
better off doing this
yourself in Disk Utility in
Recovery mode.

HOW TO CHANGE THE PASSWORD

OF A SPARSE BUNDLE?

A bug was introduced around macOS 13.3 that
stopped changing passwords of sparse
bundles using “hdiutil chpass”, although it still
works fine with other types of disk image. Until
a fix, the only way to change a password is
using “hdiutil” in a virtual machine running

13.2 or earlier.

Image rights: Apple Inc.

DOES MACOS BIG SUR CHECK

ITSELF FOR MALWARE?

Yes. On—-demand checks are run as part of
Gatekeeper on quarantined apps:; it also runs
anti-malware scans at least once a day using
new XProtect Remediator software. Although
the checks are the same as in Ventura, the
newer macOS runs on-demand checks more
frequently than in Big Sur.
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Does your Mac sigh when it starts or creak
when it calculates? We're here to help

ITH THE WEEKLY

shop costing more

than a carand
everything from energy to
entertainment suppliers
charging eye-watering prices,
many of us are choosing to
hang on to our Macs for a little
bit longer. And that's a wise
choice, because with a little
bit of TLC, Macs can last for a
very long time. With some
Macs, inexpensive hardware
upgrades can deliver a serious
speed boost — and with all
Macs, a bit of tinkering and a
few alternative apps can make
a massive difference too.

It's important to be

realistic, of course. macOS
Ventura won’t run on a Power
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Mac G4, and you won't get
M2-beating performance from
the 667MHz processor of a
2006 aluminum MacBook Pro.
But pretty much any Mac of
relatively recent vintage can
be tweaked, given extra
storage, and in many cases
given more memory too.

In this feature, we'll
breathe new life into all kinds
of Macs. We'll discover how to
safely install the macOS
versions Apple doesn't want
your Mac to run, and we'll also
take a look at the apps you can
use if Apple’'s own are no
longer being updated for your
system — in most cases,
without you having to spend
any money at all. And we'll

discover the tools you can use
to access files from long-gone
apps too.

That's not all. We'll show
you how to make a clean
installation of macOS to clear
out the electronic lint that
every computer accumulates,
and we'll take you through the
process of swapping out your
storage or boosting your RAM
— something that's pretty
much impossible on the most
modern Macs but pretty
straightforward and very
affordable for older ones.

Plus, discover the
emulators that enable you to
experience or revisit the Macs,
the apps, and even the games
of the 80s and 90s.
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ne of the most important
things you can do with your Mac
is keep it up to date, and for
current versions of macOS and Mac
apps that's usually straightforward:
just ensure automatic software updates
are available for both your operating
system and your apps, and you're
good to go. But things become more
complex with older software, such as
operating systems that Apple no longer

supports or apps that the developer doesn't.
In some cases, you can find an alternative to
now-defunct apps, but what if you need

to access files made in an app that Apple no
longer lets you run?

Apple locked out 32-bit apps in macOS
10.15 (Catalina), but you can still run them in
emulators such as Parallels, VirtualBox or
Retroactive (https://bit.ly/3qX125S). That
last one’s particularly great for creative types
who need to open files from apps such

Create a clean install of macOS

as Logic Pro 9, iPhoto, or Aperture on
modern Macs.

If you really want to kick it old school, you
can emulate old Macs on modern ones via
Mini vMac [www.gryphel.cofn), which
emulates a Mac Plus, or emulate other
PowerPC Macs in SheepShaver
kheepshaver.cebix.net) or QEMU
emu.ord). As for the old apps, you can get
them from the Macintosh Repository

(https://macintoshrepository.org).

Ma App Sses P

E% macos Big S

Back up your Mac

We can't stress this enough: make sure
that you have a full backup of everything
you want to keep on your Mac, because
we're going to do what's called a clean
install — that's when you create a factory-
fresh version of macOS.

Download macOS

We need the macQS installer from the
Mac App Store. Unfortunately, a bug means
the download often fails for Big Sur. To get
around that, launch Terminal and enter:
softwareupdate --fetch-full-installer
to download the installer.

Top 10 apps for older Macs

Plug in USB

Now make a USB bootable installer.
For that, you need a 16GB or larger USB
flash drive and the macOS installer. The
latter must be in your Applications folder.
Plug in the USB flash drive; if you've closed
Terminal, open it again.
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Free

4 The free Firefox
‘i browser is one of
the most powerful, privacy
protecting, and flexible web
browsers on any operating
system, and it's available for
every macOS from Sierra
onwards. Its available
extensions and add-ons
massively outnumber
Safaris ones.

AUG 2023

Free

n This fast, free

9 alternative to Mail

works with mac0S going

back to Sierra and has

very small system

requirements. It looks

and feels pretty retro

but it's a very powerful

app with lots of

customization options
and add-ons.

Free

@ It's a little harder
« tolearn than

Photoshop or Affinity, but
GIMP delivers serious photo
and image editing power
for zero money. Versions
since 2.8.2 run natively in
mac0S without additional
software, and they're

made for Macs running
Sierra onwards.

Free
If you have Mojave
or later, you can run

this free alternative to
Microsoft Office, which is
based on the solid

(if fairly dated-looking)
foundation of OpenOffice
and delivers an impressive
collection of writing,
spreadsheet, and
productivity features.

Free

This hi-res music

player works on
macO0S El Capitan onwards
and supports all the key
formats including FLAC,
Apple Lossless and more.
[t works with your iTunes
music library and also
provides thousands of
online radio stations. It's
a great Music alternative.


https://sheepshaver.cebix.net/
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https://bit.ly/3qX125S
http://www.gryphel.com
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https://macintoshrepository.org
http://mozilla.org
http://thunderbird.net
http://gimp.org
http://libreoffice.org
https://www.qemu.org/

Make a

bootable drive
You now need to enter the
appropriate code into a new
Terminal window. The
commands vary according to
each macOS version; the
different commands are
all helpfully listed on the
Apple website at
tinyurl.com/macbootusb]

Erase APFS volume group "Macintosh HD"?

Time to wait
Press Enter, and
now you can step away for a
bit: this part takes some time.
Terminal will keep
you updated about its
progress until the bootable
USB drive has been
created. You can then
quit Terminal and shut
down your Mac.

Breathe new life into your old Mac

Reboot your Mac
Restart your Mac and
if it's an Intel one, hold down
Opt until you see the
boot options menu; on
an M-powered Mac, press
and hold the Power button
until the menu appears.
On either kind of Mac,
you should see the macOS
Utilities screen.

Change the

security settings
On some M-powered Macs
you may get a security
error. Reboot your Mac,
hold down Cmd+R for
Recovery mode, select
Utilities > Startup Security
Utility, and enable Allow
Booting From External
Media. Retry step 5.

Erase your Mac

Select Disk Utility from the options,

Install macOS

Once Disk Utility has finished

Start from scratch

Congratulations: you now have a

choose Macintosh HD (or whatever you
want your main drive to be called) as the
disk name and select APFS as the file
system. Now choose Erase. Note: This
removes everything from your drive.

Free
Made for mac0S

s Mojave or later, this
streamlined note-taking app
is more powerful than it
looks: it supports Markdown
formatting so it's as much
a writing environment as
a Notes alternative.
SimpleNote also offers
an iPhone/iPad app with
built-in syncing.

Free
L
The free VLC Media Player is
much more flexible than
either Apple’s own TV app or
QuickTime Player: it
supports almost every kind
of media file and has a
dizzying range of audio and
video filters. It's very fast,
even on very modest Macs.

formatting your main drive, you can quit
Disk Utility. This will take you back to the
macQOS Utilities screen. You can choose the
Install macOS option by selecting the
bootable USB drive from the options.

$24.95
e Has Apple stopped

= supporting your
scanner in mac0S? Don't
worry: VueScan will almost
certainly have it in its
massive library, even if it's
ancient. It supports over
7100 scanners from 42
manufacturers and makes
it easy to scan documents
and photos.

Free
Spotlight is great,
but Alfred can do

even more than finding
things and launching apps.
It's available for Mojave
onwards (version 4 is
available for El Capitan) and
enables you to do all kinds
of things including
automating everyday

tasks and actions.

pristine copy of macOS, free from the chaff
that accumulates in any operating system
over time. All you need to do now is restore
your apps and files from your backup and
pick up where you left off.

From $2.99/month

a)
< ApplesiCloud

Keychain app is great for
storing your logins, but it
doesn't work with non-
Apple apps. 1Password does,
and it supports not just
non-Apple browsers like
Firefox but also non-Apple
devices, so you can take all
your passwords to PCs too.
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oday’s Macs aren‘t very

upgradable, especially if they run

Apple silicon: on an M1 or M2 chip,
the graphics, memory and processor are all
on the same, non-replaceable chip and the
SSD is not user accessible or replaceable.
But older Macs are much more
accommodating and Intel-based Macs are
relatively easy to upgrade.

With memory upgrades you'll need to

know not just the supported maximum
memory but the type of RAM too and what

configurations your particular Mac supports.
Many manufacturers will help you with this,
so for example has a good
memory finder for Macs.

As you'll see from these examples,
upgrading your Mac requires a bit of work,
but it's not too difficult providing you have
the right tools. These will typically include a
small Phillips screwdriver and, for later model
Intel Macs, a selection of small Torx
screwdrivers. Keep the tools away from your
Mac until you've unplugged it from the wall.

Upgrade your memory

CaniFixit?

Yes you can!

We Ioveits upgrade kits don't
just give you the part(s) you need, but also the
myriad screwdrivers and other tools required
to make your Mac upgrade or repair as
effortless as possible. And you don't need to
buy their upgrade kits to benefit from their Mac
hardware expertise — their excellent

online guides are free to read or to watch.

Gl J
o

Remove the cover
Every Mac is different but, for
example, here on a mid-2012 13-inch

MacBook Pro, there are ten external
screws of differing sizes to remove
before you can prize open the lower

case of your Mac.

52 | AUG 2023

Disconnect the battery

A very important next step: you know
not to open up a Mac without first
unplugging it from the wall, but with
portable Macs such as MacBooks you also
need to disconnect (or remove, on older
Mac laptops) the battery.

Replace the RAM

The memory chips on this Mac (and
on iMacs of similar vintage) are held in place
by little retaining arms that you'll need to
gently pull apart before you can slide out
the RAM, swap in the new chips, and
reconnect the battery.


http://www.crucial.com
http://www.ifixit.com:
http://ifixit.com

Upgrade your storage drive

Breathe new life into your old Mac

Keep the battery clear

As with RAM replacement, step one is
to open up your (disconnected) Mac and
unplug the battery connector. It's a good
idea to gently bend the battery connector
back on models such as this 13-inch
MacBook Pro so it won't reconnect.

Upgrade your SSD

Extract the old drive

On this Mac, the hard drive is secured
by two Phillips screws and then a bracket,
shown here. You'll need to take that out
and gently lift out the hard drive by its pull

tab; disconnect its cable and remove the

drive completely.

Take the posts

There are four retaining posts on the
hard drive, two on either side, with Té Torx
screws. You'll need to transfer them across
to your new drive or it won't sit properly
inside your Mac. Once everything's in place,
install macOS.

Openitup

Early Mac SSDs were fast but limited in
storage space, so many of us quickly ran
out of room. Don't worry, you don't need to
carry a selection of external drives around:;

Unplug the battery
Retina MacBooks aren't hugely
accessible, but it's easy enough to locate
and unplug the battery connector shown

here. Don't do anything else until the

simply pop open your Mac and swap the
SSD for something more roomy.

'y

LACIE

battery has been disconnected and moved
gently out of the way.

If you can't upgrade your Intel Mac's hard
drive to the size or speed you want, don't
worry: just go outside. By booting from a fast
external solid-state drive (SSD) instead of a
relatively slow hard disk, you can make a real
difference to your Mac's performance.

The important thing here is the
connection and file format. USB 2.0
connections just aren’t fast enough — you
need USB 3.2 or Thunderbolt and a

Swap the SSD

The SSD is held in with a single Torx
screw. Unscrew it, then gently lift the free
end of the SSD about 0.2"; you should be
able to pull it out of its socket. The new SSD
goes in the same place, secured with the
same screw.

compatible drive — and you need to choose
the right format. For macOS Sierra onwards,
APFS is the fastest option; for older Macs, go
for Mac OS Extended, aka HFS+. You can
format the drive in Disk Utility, then select it
as your destination disk during the macOS
installation. You can change your startup
disk by going to the Apple menu; choose
System Settings > General > Startup Disk.
Apple has more details atlapple.co/42LxLbJ!
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ave a 2017 MacBook Air and want

Ventura on it? Sorry, you're out

of luck: it, and all Macs made before
2017, aren’t supported. So why does Apple
end operating system support for perfectly
good computers?

Part of the answer is undoubtedly

to sell new Macs. But there are more
important factors here. Operating
systems can encounter issues with new
software or newly discovered security
flaws, and fixing those issues costs money.
And then there are device drivers, the little

bits of code that enable your Mac to talk

to crucial components that are often

made by third parties — AMD or Intel for
GPUs, Broadcom for Wi-Fi radios and so on.
Those third parties don't keep updating
their drivers forever, and when their
updates stop that threatens the stability
and safety of macOS. Few manufacturers
will happily pay to patch their operating
systems in perpetuity. Some Android firms
only promise OS updates for two years from
launch, so Apple’s six-ish years is positively
generous by comparison.

Create the macQOS installer

ae OpenCore Legacy Patcher (0.8.5)
OpenCore Legacy Patcher v0.6.5
Model: MacBookProl2,1
[Bultd and Install OpenCore
Post Install Root Patch

Create moacOS Installer

Settings
Help.

Get the patcher

The first thing you need to do is
download OpenCore-Patcher (GUI)
from
Once it's downloaded, run the app
and you should now see a window
like this one.
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Create macOS Installer
Download macOS Installer
Use exlsting macDS Installar

Return to Main Menu

Create the installer

Click on “Create macOS Installer”
and you'll be given a choice of using an
existing installer or downloading it. Go
for the download option as this will ensure
you get the most up-to-date version of
macOS for your Mac.

Whatis OpenCore?

OpenCore is a boot manager, a piece

of software that sits between your Mac
hardware and your mac0S software

and performs clever tricks to enable
officially forbidden versions of mac0S to
load and run properly on your computer.

It does that by injecting and patching data
to deliver as close to a fully native mac0S
experience as possible.

Download macOS Installer
Installers currently avallable from Apple:
macOs 11.7.6 (2061231 - 12.4 GB)
macO5 12.6.5 (216531 - 12.4 GA)
macOS 13.3.1 (226261 - 11.3 G8)

Show all available instaliers
FReturn to Main Menu

Pick your macQOS

As you can see, we have three
choices here. We want the most recent one,
which is the one with the highest version
number; at the time of this screenshot
that means the latest Ventura build,
which was 13.31.


https://bit.ly/3N9AWnQ

Download and install macQOS Ventura

Breathe new life into your old Mac

OponCoro Legacy Patcher (0.8.5)
Downloading mac0S 13.3.1 (22E261)

41.9 MB downloaded of 11.8 GB (0.36%)
Average download speed:

Return to Main Mena

Get downloading

This is another big download: this
installer is nearly 12GB, and it can be very
slow to download. Wait until you're sure the
download has started — the MB
downloaded number will start to rise — and
then go and do something else.

Get Ventura up and

Install OpenCore to disk

At the moment all you have is a macQOS
installer. You also need OpenCore to trick
your Mac into letting it run when it's not
officially supported, so you need to click on
“Install OpenCore to disk” here. If you don't,
your installation won't work.

OpenCore Legacy Patcher (0.6.5)
Format USB
Selected USB will be erased, please backup your data

Missing drives? Ensure they're 14GB+ and removable
disk3 - TransMemory - 15.5 GB

Return to Main Menu

Add your USB

You'll need a 14GB or larger USB drive
for this next bit, so insert that into your
Mac’s USB port once the installer has
downloaded. You'll now see a list
of available USB drives — in this case,
we just have the one.

running

Reboot your Mac

Restart your Mac with the Opt key
held down until you see this boot screen.
Don't click on “Install macOS Ventura” just
yet; you need to use the next option, EFI
Boot. That's the bit that persuades your
Mac to let Ventura on board.

It's very important that you
understand the limitations of a

it comes without a warranty or

on your own. The second is that

bootloader such as OpenCore. The
first and most obvious one is that

support, so if it goes horribly wrong
— something that's unlikely but still
possible — and bricks your Mac, you're

OpsnCore Legacy Patcher (0.6.5)
Creating Installer: Install macOS Ventura

Sytes Writton: 3724.7M8

Flash the drive

OpenCore-Patcher will now turn your
USB stick into a bootable macOS
installation drive. You can't skip or speed up
this step, so unfortunately that means
another wait — especially on older, slower
USB flash drives.

Install Ventura

Running the EFI Boot option moves
OpenCore into memory, so now you can
choose the Install macOS Ventura option.
This will work like any normal macOS
installation. If you encounter issues, there's
help on the OpenCore site.

Apple may (and likely will) decide to
block it. And the third is that you're
letting someone else play god with
your Mac, and that someone else
doesn’'t have Apple's resources to
find and fix any security issues or
massive bugs that might occur. If that
sounds a bit scary, then a bootloader
is not the right solution for you.
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here’satropein TV dramas where

doctors or paramedics battle off-

screen to save a beloved character
before returning to break the bad news to
their loved ones: “We did everything we

could,” they’ll say, “but it just wasn't enough.”

It's a bit like that with some Macs, albeit with
less tears or cheesy acting. But just because

[

(IR

Streaming on a home network isn't
particularly demanding, and that means
old Macs can easily be redeployed as
streaming servers. One of the simplest
options is the free, polished and popular
Plex Media Server. It can turn any Mac
running mac0S 10.13 (High Sierra) or later
into the hub of your home entertainment,
streaming from a variety of online services
as well as from your own digital library
of music and video.
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an old Mac is on its way out doesn't mean it
can'tlive onin our hearts, or as part of our
home decor. It turns out there's an awful lot
you can do with an old Mac, evenif it's
completely stopped working.

If your Mac is old rather than broken, one
thing you can do is run a different operating
system on it — either through emulating an

=]

Apple Mac G4 Computer

Don't expect to make huge sums unless you're
selling an unopened first-gen iPhone. But there
are still plenty of Mac enthusiasts who'll be
happy to buy your old Mac. Don't forget about
shipping costs, though: a Power Mac is going to
need more than a few stamps to get it to its
destination. We'd recommend trying

Facebook Marketplace, Craigslist and

other local marketplace services first

before going with eBay.

old macOS or by installing, say. Chrome or
Linux. A lot of old Macs are doing sterling
service today as networked drives and/or
media streamers, and others have gone on
to new lives thanks to computer charities. If
all else fails, you can even make your Mac
into a clock, coffee table, or makeup mirror.
Allyou need is a little bit of imagination.

WHETHER YO
AN INDIVIDUAI
REAL DIFFERENC

< v ‘:-__. £

If you're a power user, a Mac that's

no longer powerful enough for what

you do might still be perfectly powerful
for less demanding tasks: you don't

need to have an M2 processor for a

bit of word processing, letter writing,

or online shopping. There are lots

of charities that'll take working computers,
but make sure you wipe all your personal
data before you hand it over — “Erase it”"
on the next page tells you how.



http://www.ebay.com
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[https://infinitemac.orgl

Many of the suggestions here involve passing your
old Mac on to somebody else, whether that's to a
friend, to a marketplace or auction buyer, or to a
charity. If you're doing any of those things, or
getting rid of your Mac via recycling, it's crucial
that you wipe your Mac first to ensure that your
personal data and documents can't be accessed
by anybody else.

Although there are third party apps to do that
for you, Apple silicon Macs running mac0S
Monterey or Ventura have built-in tools under
System Preferences / System Settings. For Intel

Erase All Content & Settings

Macs it's a bit more complex: you'll need to sign
out of every service you use on your Mac,
de-authorize accounts, unpair Bluetooth, and
then restart your Mac in Recovery mode.

You can then erase your Mac and reinstall a
clean copy of mac0S.

macOS Monterey

mac0S Ventura doesn't let you run older apps
that long predate your hardware — but
does, and it does it in your web
browser. It's the latest in a series of web-based
Mac emulators and it can load/save files from a
local drive as well as from its own Infinite HD of
apps and games. You can even network with
other copies of it. If you'd rather run something
locally, Basilisk I[(https://basilisk.cebix.net) is
available for Intel and PowerPC Macs and can
emulate a Mac Classic running up to Mac 0S 7.5
or a Mac Il running up to Mac 0S 8.1. They're
great fun and, because by modern standards
they have tiny system requirements, they're
speedier than old Macs ever were.

https://linuxmint.co
Have you always wanted to turn your Mac
into a Chromebook or a Linux computer?
It's easier than you might think. Chrome
Flex is a super-light Chrome 0S from
Google, and Linux Mint is arguably
the most Mac-like and definitely one of
the most welcoming Linux options.
Both have good alternatives to the apps
you'e used to on your Mac, and both have
detailed installation instructions online.

[www.virtualbox.org|
If your hardware needs to be put out
to pasture but you still need to run
certain apps or access files, you can
run mac0S very well in a virtual machine
on a Windows PC: Oracle’s VirtualBox and
VMware's Workstation Player can run a full
version of macOS inside Windows so you can
still access your stuff even if you've left the
Mac behind. If the PC's relatively recent
it should run fairly quickly too.

[www.etsy.com/shop/mactechnology]
If you look on Etsy, you'll see old Macs made
into all kinds of things: keyboards turned into
wall clocks, ancient iMacs working as
aquariums and in the case of MacTechnology,
Power Macs turned into coffee tables and
flat-screen iMacs made into mirrors. There's
even an iMac makeup mirror with its own
integrated LED lights.
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BEGINNER'S GUIDE TO

Beginner’s guide to Time Machine

Time Machine

Time Machine is built into macOS, so there’s
no excuse for not backing up your Mac

’ APPLE FIRST LAUNCHED
Time Machine 15 years

' ago in an attempt to
make it as easy as possible for Mac
users to back up regularly, and be
able to restore anything from a single
file to their entire Mac with the
minimum of fuss.

Time Machine was launched
alongside a neat piece of Apple
hardware known as Time Capsule,
which combined an AirPort router and

Image rights: Apple Inc.

WRITTEN BY KENNY HEMPHILL

| ahard drive. The idea was that you

would use the networked hard drive
with Time Machine to back up
portable Macs wirelessly. Time
Capsule was discontinued in 2018, but
Time Machine lives on and was
overhauled following the introduction
of the Apple File System (APFS) in
macOS Sierra.

You can use any locally
connected hard drive or SSD as a

| destination for Time Machine

backups. You can also use a folder on
a Mac connected to the same network,
or a network-attached storage (NAS)
device. Not all NAS work with Time
Machine, though; the device must
support either a recent version of
SMB or the now—deprecated Apple
Filing Protocol (AFP). To use

a NAS, you’ll need to consult

the manufacturer’s instructions

on how to set it up for use with

Time Machine.
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Time Machine

Time Machine backs up your computer and keeps local snapshots and
heurly backups for the past 24 hours, daily backups for the past manth and
weekly backups for all previous months. The oldest backups and any local
snapshots are deleted as space is neaded.

Archive
367.41 GB available
—

28.3% done - Calculating time remaining...

199.4 MB copied

Options... 7?7

How to use Time Machine

Set it and forget it — once done, you won't even know Time Machine is running

TIME MACHINE CREATES

*‘ incremental backups of
your Mac. This means

that every time a backup runs,

it copies only the files that have
changed since the previous backup. It
saves snapshots of your data once
every hour for the previous 24 hours,
once a day for the past month, and
once a week for all previous months.
That way, you can roll your Mac back
to the state it was in at any point in

the previous 24 hours, as well as
recover files that were deleted a
month ago. Time Machine keeps
monthly backups until it runs out of
storage space, at which point it
deletes the oldest. As well as using
Time Machine to recover files, you
can use it with macOS Recovery when
you reinstall macOS to recover
settings from your previous install.
Time Machine stores snapshots on
your startup drive, so you can restore

QUICK LOOK Time Machine’s interface

from them even if your Time Machine
backup drive isn’t available. It stores
hourly snapshots for the previous 24
hours, as well as a copy of the last
successful backup. Local snapshots
are only saved if space is available,
and the space they occupy is marked
as available by macOS, so they don’t
reduce the available capacity of the
drive. Restoring from local snapshots
is automatic when your backup disk is
not available. ®

CONTROL
PANEL °ee
When a backup is Q Searth
running, this s

() Network
progress bar tells ®

you how long it has
left to run.

3 netitications

£ sound
Fotus
Screen Time

ampe 0O
aﬁpbmnp_e 1 .

(@) Accessibility

£ control Centre
B sii & spotiight
[ Privacy & Security

QUICK LINKS
The “+" allows you
to add another disk
as a Time Machine
destination and the

“-" to remove one.

B eskiop & Dack
£3 vispiays
|5 Sereen Saver
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< Time Machine

Time Machine

HELP
Options allows you
to choose backup

- Tume Machine backs up your computer and keeps local snapshots and

hourly beckups for the past 24 hours, daily backups for the past month and

frequency, set

wieekly backups for all previous months. The oidest backups sod any local

snapshots are deleted as space is neaded,

ﬂ Archive
372,04 GR availsbie

———
:24.9% done - About 2 minutes remeining
& 50 GE copied

maximum disk usage,
and exclude folders.

eomions.,. ?

APPEARANCE
Having had its own
pane in System Prefs,
Time Machine is now
found in System
Settings > General.

Image rights: Apple Inc, LaCie.



HOW TO Set up Time Machine

Beginner's guide to Time Machine

Choose a drive

Pick a drive to use as a backup
destination. You can use any volume

on a locally connected drive. But if there
is data on it, Time Machine will wipe it
before it starts the first backup. You may
also be able to use NAS.

. < Time Maching.
e T e e 1 Pom k38 ), s ki 1 T S
b i sk .

Anturranicaly Every Wi

Exciude from Backups
B fppicatiom

Mty |
ko e R
Bk i oo Battary Bt el

B -fOowrinads:

Choose options

Time Machine schedules
backups automatically. You can change
that. Click Options and make a selection
from Backup Frequency. If you want to
back up a MacBook even when running
on just battery power, turn that on.

Stop a backup

If you need to stop a backup for
any reason, click the Time Machine
menu bar item and choose Stop This
Backup. You can restart a backup when
you're ready by clicking the menu bar
item again and choosing Start Backup.

Image rights: Apple Inc, LaCie.

Select the disk

Connect the drive to your Mac
and wait for it to mount. From the Apple
menu, choose System Settings. Click
General, then Time Machine. Click Add
Backup Disk, choose the volume you
want to use, then click Set Up Disk.

Exclude folders

You can choose to exclude
folders, like the Applications folder, from
backups. To choose what to exclude,
click the “+" in Options, navigate to the
folder and select it, or drag a folder onto
the window. Click Done to finish.

LR € Time Machine

& ey @ T

Remove a

backup drive
If you no longer want to use a drive,
go to System Settings > General > Time
Machine. Click “X" next to the progress
bar if a backup is running. Click “-" and
confirm to remove the drive.

L] © Tarm Machine
ot Nt =it
PP
[ Beimasena
s Exh
Ercryse Bk L &
Hoew Sasswerd |
e eoer Fasamecnd
it
Doskc Uisage Lima O Nane  Custom
> e QI

Finish setting up
If you want to encrypt your
backups, leave Encrypt Backup set to
On and type in a password, re-enter the
password, and type a Hint. To set a disk
usage limit, select Custom and set a
limit. Click Done to finish setup.

-  Fri 19 May 18

o Manually

start backup

If you set Time Machine to only back up
manually, or if it hasn't backed up for a
while and you want to start a manual

backup, click the Time Machine icon in
the menu bar and choose Back Up Now.

Latest Backup 1o “Ar
Today, 19115

Open Time Machine Settings...

Fix a problem

Backups sometimes fail to
complete, for a number of reasons. If
this happens, click Time Machine in the
menu bar, choose “Open Time Machine
Settings” and click the red “i" to find out
what caused the failure and resolve it.

AUG 2023 | 61



oy

5 Creative Cloud Files

[ Documents

& Users
Gal Pictures
J7 Music
B Movies

@ Desktop

E3 Freelance documents

B Invoices

Tl CleanShot 20.
L CleanShot 20..

i~ CleanShot 20..;

&= CleanShot 20,

Desktop

Adultt 25Apr2023.pdf
CleanShot 20...t 17.16.09@2x
LAt 1717.33@2x
at12.18.02@2x
CleanShot 20...t 17.18. 55@2x
CleanShot 20...at 17.19.02@2x
_ CleanShot 20...t 18.46.52@2x
. CleanShot 20...t 15.24.28@2x
CleanShot 20...at 17.10.57@2x
i CleanShot 20...t 14.13.48@2x
CleanShot 20....14.16@2x.png
= CleanShot 20...14.16@2x.pxd
t 14.15.57@2x
t 17.30.13@2x
-117.31.59@2x
CleanShot 20...t 19.03.42@2x
_ CleanShot 20...t 19.05.34@2x

CleanShet 20...

28 items

Time Machine gets its name from the way its interface

allows you to roll back to previous days and weeks.

Recover your data

Whether you need just one file, or to restore an entire Mac — find out how

WHEN APPLE FIRST

v‘ launched Time Machine,
it pitched it as a way to

roll your Mac back to an earlier point
in time, before you made changes to,

or deleted, files. With a skeuomorphic

interface typical of Apple at the time,
invoking Time Machine seemed to
enable you to travel back in time via

HOW TO Recover files

Finder windows from an earlier age, or
at least a few days ago. The
skeuomorphic time travel has gone,
but Time Machine’s interface remains
much the same, displaying stacked
Finder windows and arrows to
“travel” back and forth. When you
find the date you want, you can then
navigate the Finder as if you were back

in Time Machine

13/05/2023, 18:03

to that date, then find and restore the
files you have changed or deleted.
Time Machine is now integral to the
process of recovering from a software
catastrophe. It’s the first option in the
list when you boot into Recovery mode
and launch macOS Utilities. And, if
you reinstall macOS, you can use Time
Machine to restore files and settings. m

Latest Backup to A i
Today, 1915

Launch
Time Machine

Locate a backup
Navigate through the backups

Restore a file
When you find the backup you

If you've deleted a file or need an earlier
version of one, click the Time Machine
icon in the menu bar and choose
Browse Time Machine Backups and wait
for stacked Finder windows to appear.

AUG 2023

by using the up and down arrows to the
right of the Finder window. Note the
date and time displayed between the
arrows and keep going until you find the
date and time you want.

need, search for the file required or
navigate around the Finder window

as you normally would. When you locate
the file, click Restore to make that
version replace the current version.

Image rights: Apple Inc.



Beginner's guide to Time Machine

HOW TO Use Time Machine in macOS Recovery

V)

Migration Assistant

# o4 ngve Siormacion on anctmer Mac Or 8 Windows PO, 5 Can ransfir & tn his Mac, You <an aisy
Urtar i raticn frem o T Machane Bachi oo atithe slartu Sk

Fieaw s,y seard 5 Iravatar yong infcrmation”

© From s Mac, Tame Maechine Sachup or Starhup dese
Frsm & Windows PC
T aresthar bae:

Recovery mode

On an Apple silicon Mac, shut
down, then press and hold the Power
button. Click Options from the startup
options, then Continue. On an Intel Mac,
boot while holding Cmd+R and release
when you see the Apple logo.

Restore from

a backup
In the macOS Utilities window, choose
“Restore from Time Machine” to recover
all the files and settings from a recent
backup. Follow the instructions
on screen to choose a backup.

Restore macOS

To reinstall macQOS, choose that
option from macQOS Utilities. Follow the
on-screen instructions. When Migration
Assistant launches, choose “From a
Time Machine backup or Startup disk”,
click Continue and choose the backup.

HOW TO Work smarter with Time Machine

V)

Migration Assistant

90 have infomarins o anathar Maq or B Wndows PC, 4 can ranster & b s Mac. You can also
tramudar inbir matite, b a Tine Machine Efchi or asdther slartup dak

How o yeu want e ranele yal ndarmatien?
10 From a Mac, Tima Maching backap o S1rkp disk
e
o snoeer b

Preview a file

If you're not sure whether a file
you find while using Time Machine is the
one you actually want to restore, you
can preview it using Quick Look. Just
select it in the Finder window as normal,
and press the Spacebar.

Navigate quickly

If the file you want to restore is
several days or weeks old, instead of
using the arrows to find the backup,
move the pointer to the bottom right
of the screen, then up the notches that
appear until you reach the date.

Set up a new Mac

To set up a new Mac with a Time
Machine backup of your current Mac,
connect the backup drive to the new
Mac the first time you boot it. Choose
the first option in Migration Assistant
and select the Time Machine backup.

> ALTERNATIVES TO TIME MACHINE
Third—party options for backing up your Mac

stz - sl timy

Sanbion - thares users
Santios - sharss users snd apglcations

Rackup - afl Shes
Werw Caagy Sonot
Tl b Selectnd Capy Setipr
ractores e an e S s

There are several third-party options for creating backups of your Mac. Tools
like Backblaze (Www.backblaze.com) and Carbonite (Www.carbonite.coml
have Mac clients for their proprietary service. Of the tools that back up your
Mac to an attached disk, Carbon Copy Cloner (https://bombich.coni) and
SuperDuper (https:/shirt-pocket.com] allow you to create bootable clones
of your Mac, as well as schedule multiple backup routines. And ChronoSync

(www.econtechnologies.com) lets you schedule the synchronization of

folders on your Mac with folders on an external drive.

Carbon Copy Cloner and SuperDuper allow
you to create bootable clones of your Mac.
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APPLE HAS TAKEN
EVERYTHING WE KNOW
ABOUT THE “"WORLD'S
BEST-SELLING LAPTOP”

AND SUPER-SIZED IT
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The Apple silicon M2 chip
inside the MacBook Air 15in
comes with eight CPU cores.

The Midnight finish of the
MacBook Pro 15inis a
fingerprint magnet. You
might want to consider
another color instead.

MacBook Air
15-inch (2023)

Apple's best-selling laptop gets an upgrade

$1.299 From[vwapplecon]

Features Apple M2 chip, 8GB unified memory (16GB/24GB available), 15.3in Liquid Retina display
(2.880 x 1,864), 256GB storage (512GB/1TB/2TB available), Wi-Fi 6 (aka 802.11ax Wi-Fi),
Bluetooth 5.3, 2x Thunderbolt/USB 4 ports, MagSafe 3 port, 3.5mm headphone jack

NOW HERE’'S A SURPRISE: Apple has taken
everything we know about the “world’s
best-selling laptop” and super-sized it,
increasing the dimensions of its Liquid Retina
display from 13.6-inch to 15.3-inch.

That's brilliant news for anyone who wants a
big-screen laptop from Apple but can’t afford
the current 14-inch and 16-inch MacBook Pro

(which start at $1,999 and $2,499 respectively).

The MacBook Air 15-inch starts at $1,299.
That entry-level price nets you a slim, stylish
and beautifully built laptop equipped with an
Apple silicon M2 chip comprising an 8-core
CPU, 10-core GPU, 8GB of unified memory
and 256GB of storage, while the step-up
$1,499 model gets 512GB of storage. To
increase the specs from there, you'll need to
delve into the build-to-order options, where

costs can rapidly ramp up — choosing 16GB of
memory will add another $200 to the purchase
price, while 24GB will set you back $400.
Likewise, increasing the amount of on-board
storage costs $200 for a 512GB SSD, $400 for
a1TB SSD, and $800 for a 2TB SSD. The
version we're reviewing costs $1,699 with 16GB
of memory and 512GB of solid-state storage.

If any of the above is still too cost-
prohibitive for you, you have options; choose
an M2 MacBook Air 13-inch at $1,099 to start,
or buy the M1 version, which is still on sale for
$999. Or, of course, you could forego portability
completely and get an M2-equipped Mac mini
for $599, though you'll need to add your own
monitor, keyboard, and mouse or trackpad.

The MacBook Air 15-inch, though, is to a
large extent the exact same machine as the
13-inch we looked at in our October 2022 issue
(#198), albeit with a few welcome changes. The
chief of these is the bigger 15.3-inch display,
of course, which has super-narrow bezels, a
cut-out (or notch) for the 1080p FaceTime HD
camera at the top, and a resolution of 2,880 x
1.864 pixels. It includes True Tone for
accurate colors in ambient lighting,

and has a beefed-up audio
system with six speakers instead
of the 13-inch model’s four.
Like the MacBook Air 13-inch, the
15-inch Air has a full-sized backlit QWERTY
keyboard with Touch ID and an oversized
trackpad on the top, plus a MagSafe 3 port and
two Thunderbolt/USB 4 ports on the left, and a
3.5mm headphone jack on the right. And, since
it has the same square-edge unibody design
of the 13-inch Air, it's no surprise that it's also
available in the same four color finishes —
Midnight, Starlight, Space Gray and Silver.
Midnight is actually a very dark blue and
shows finger marks much more clearly than
on other Apple laptops we've used.
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The latest MacBook
Air comes with a
15.3-inch Liquid
Retina display,
giving you more
screen real estate
to play with,

without paying
MacBook Pro money.

The MacBook Air
15-inch is heavier
than its 13-inch
cousin, but it's
still one of the
most luggable
laptops around.
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The other thing to note is that while the
MacBook Air 15-inch is still much lighter than, say,
the 14-inch MacBook Pro (3.3 vs 3.5 pounds), it's a
chunk heavier than the 13-inch Air, which weighs
in at just 2.7 pounds. That's the price you pay for a
bigger screen and a larger battery.

Whichever MacBook Air model you choose, you
can be assured of legendarily long battery
life, with both the 13-inch and 15-inch models
offering up to 18 hours of video streaming or
15 hours when surfing the web — something
that was borne out by our testing, which we're
coming to next...

PERFORMANCE
While the MacBook Air has never been a
powerhouse laptop (that’s not its raison d'étre
after all), its performance has come on leaps and
bounds in recent years, most notably with the
arrival of Apple silicon in 2020. The M1 MacBook Air
then was a revelation compared to the Intel-
powered MacBook Air before it, and while the M2
chip doesn't move the dial on from the M1too
much, it still makes a cast-iron (or should that
be aluminum?) case for consideration as an
everyday laptop for the rest of us (the MacBook
Pro now being out of the reach of most). That's
also been substantiated by our benchmarks,
where we run a series of tests that put the
machine through its paces.

In Geekbench 5, for example, the latest
MacBook Air averaged 1,908 points in its single-
core test, putting it a hair above last year's M2

MacBook Pro 13-inch on 1,903, and considerably
ahead of the original M1 MacBook Air we tested in
2020, which achieved a score of 1,705. In
Handbrake, the M2 chip inside the MacBook Air
15-inch converted our one-hour 4K video

in around 30 minutes, seven minutes slower than
the MacBook Pro 13-inch, but still some

14 minutes faster than the M1 MacBook Air

from 2020.

Those scores were reflected, too, in our DaVinci
Resolve benchmark, where we render an effects-
laden video. Here, the M2 MacBook Air 15-inch
performed the task in around 24 minutes vs the
13-inch MacBook Pro’s sub-20 minute score,
while the M1 MacBook Air took over 29 minutes to
complete the task.

What's notable, though, is that there's quite a lot
of variability in our scores. While the MacBook Pro’s
built-in fans keep scores consistent across
multiple runs, the MacBook Air’'s fanless design
can mean it slows down under heavy workloads.
The area above the keyboard where the base of
the laptop meets the display can also get pretty
hot — not Intel “burn your legs” hot, but warm
enough to be noticeable. None of this is that
surprising — the MacBook Air is a lightweight
laptop for everyday use. Creative pros who want to
power through 8K videos all day every day should
probably look elsewhere.

Our final benchmark is on the venerable Rise of
the Tomb Raider, which runs under Rosetta 2 on
Steam. As the game isn't optimized for Apple
silicon, it maxes out at a reasonable 30 frames per



Benchmarks: Our analysis explained

Tough testing, trusted ratings

>GEEKBENCH5
SINGLE-CORE TEST

>HANDBRAKE
VIDEO ENCODING

> RISE OF THE TOMB RAIDER
(1,920 X 1,200)

This tests the capability of a single
pracessor core. Many more common
tasks on a Mac will only use a single
core at a time. Geekbench 5 is a
universal app running on Ventura.

We transcode a Blu-ray-quality video
file into H.264 format using HandBrake
to test the multicore processor
performance. Handbrake is available as
a universal binary.

For a real-world gaming test, we use
the benchmarking tool in this game,
with the graphics quality set to High
and the resolution set to 1,920 x 1.200.
Not Apple silicon ready.

Index score (higher is better)

MacBook Air 15in 3.49GHz M2 (2023)
1908

MacBook Air 13in 3.496Hz M2 (2022)

1895

MacBook Air 3.0GHz M1(2020)

1705

Duration (lower is better)

MacBook Air 15in 3.49GHz M2 (2023)
29 mins, 35 secs

MacBook Air 13in 3.496Hz M2 (2022)

30 mins, 35 secs

MacBook Air 3.0GHz M1(2020)

44 mins, 30 secs

Frames per sec (higher is better)

MacBook Air 15in 3.49GHz M2 (2023)

[N
=)

MacBook Air 13in 3.496Hz M2 (2022)

25

MacBook Air 3.06Hz M1(2020) (1920 x 1,080 res)

> DAVINCI RESOLVE

In Blackmagic Design’s editing tool for
video professionals, we exported an
effects-laden, 2.5-minute project to the
H.264 format. The latest version of the
app (Version 18) runs natively on

Apple silicon.

Duration (lower is better)

MacBook Air 15in 3.49GHz M2 (2023)
24 mins, 53 secs

MacBook Air 13in 3.496Hz M2 (2022)

23 mins, 35 secs

MacBook Air 3.0GHz M1(2020)

29 mins, 16 secs

FROM PHOTO-EDITING

benchmarks on battery didn’t tax the MacBook

TO WEB SURFING, THIS

MACHINE PROVES
QUICK AND EASY TO
USE, WHILE BATTERY
LIFE IS PHENOMENAL

second during benchmark testing. That still puts
this laptop’s performance ahead of older Intel
MacBook Air models, which could really struggle
when gaming. Again, that should come as no
surprise, but with Apple silicon-only games
beginning to appear (plus the recently
announced Game Porting Toolkit now

available for developers), the number of

recent AAA titles available for Mac should
hopefully soon change — we'll see.

In everyday use, the M2 MacBook Air 15-inch,
like its smaller sibling, is a joy to use. It starts
quickly and most apps typically launch in a
single bounce of theiricons in the Dock. From
photo-editing to web surfing, this machine
proves quick and easy to use, while its battery
life is phenomenal, easily matching Apple’s
claimed battery life figures. Even running our

Air 15-inch too much, forcing us only to reach
for the power brick (which has two USB-C ports,
incidentally) towards the end of the day.

So what's our verdict on the MacBook
Air 15-inch? It handily plugs the gap between
Apple’'s consumer-oriented MacBook Air 13-
inch and the more pro-oriented MacBook Pro by
delivering a reasonably affordable Apple laptop
with a decent-sized screen. Sure, you can pick
up laptop PCs for less, and sure, the cost of its
build-to-order options can still make you wince,
but its clever combination of screen size, long
battery life and sheer ease of use makes it the
Apple laptop you'll actually want to own.
ROB MEAD-GREEN

The Power button has Touch ID for faster logins, system
authentication, and more.

The MacBook Air 15-inch
comes with two
Thunderbolt/USB 4 ports,
plus MagSafe 3. All can be
used to power the laptop.

THE BOTTOM LINE

The missing link in
Apple’s laptop line-up
is everything you'd
hope for. It's great.
B Big, beautiful display

Incredible battery life

Quick and efficient

B Some slowdowns under
heavy workloads

AWESOME nEEEE
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THE BOTTOM LINE

Superb-sounding
headphones with a
wealth of features at a
very reasonable price.

Wonderful, rich sound

2 Excellent noise canceling

Loads of features

& Headphones battery life
a little short

EXCELLENT mmmmi
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Nothing Ear 2

Budget headphones that rival AirPods Pro

$149 From[hifps:/usnothing.tech

Features Adaptive active noise canceling, personal sound profiles, LH_DC E—res codeé, s
USB-C or wireless charging, up to 36 hours of listening time (8 hours after 10 minutes of charge)

THE EAR 2 is the latest release by UK-based
tech company Nothing which specializes in
wireless audio, and represents an upgrade to
its original Ear model. The first thing that
strikes you is the design, with the case and
in-ear headphones both using the same
transparent plastic elements which lend it a
unique look. It's also very lightweight yet well
built, with the headphones offering IP54 and
the case IP55 dust and water resistance,
making them resistant to a light rain shower,
for example.

The case charges over USB-C with a cable
included and also has 2.5W wireless charging
capability, which is a nice bonus. The
headphones will give you up to 6.3 hours of
playback with Active Noise Canceling (ANC) off
and up to 36 hours in total from the case, or up
to 4 hours and 22.5 from the case with ANC on.
The headphones’ capacity isn't stellar by
modern standards, though a ten-minute fast
charge of the case will give eight hours of total
playback, which is handy when you're in a rush.

Pairing the headphones is as simple as
opening the case and you will want to
download the Nothing X app. which provides
access to a wealth of customization features.
The headphones have an unusual pinch-to-
press system which you can set up in the app
to control things like track skip, volume, ANC
mode and answering calls. It works well and
some people will prefer it to the touch surfaces
used elsewhere, which can be too easy to
press accidentally while securing the
headphones in your ears. Three sizes of ear tips
are provided and the headphones are
comfortable and secure when worn.

The list of features continues with in-ear
detection and dual device connection, and it's
possible in the app to manage which two

devices will auto-connect. There's
personalization available too, with the app
offering multi-step processes to tailor both the
playback and ANC profiles to your hearing.
Three mics in each side help to power the
highly effective environment-adaptive ANC
and ambient modes, with variable strengths
available. They also facilitate making calls, with
voice clarity sounding very good in our tests.

JOYOUS SOUND

The headphones use 11.6mm dynamic drivers
and support multiple codecs including LHDC
for up to 24-bit streaming, as well as having
the latest Bluetooth 5.3 version. While standard
playback is good, this is an instance where you
are well advised to run through the
personalization process, since you get greater
clarity and detail once you've done this.
Crucially however once you have done the
analysis you have more options — namely low,
medium or high levels of enhancement and
within each one a variable amount slider. So it's
not simply on or off but you can really fine-
tune the processing, even if the lack of a
manual EQ is a shame.

In our test we found that the medium setting
with around a 50% enhancement level offered
the perfect balance versus the unprocessed
sound. The playback really is stunning, rich and
expansive with powerful but balanced low end,
clear mids and sparkling highs. Music sounds
joyous, bursting with energy and bags of
volume available. The fidelity and soundstage
really are remarkable and easily rival
headphones costing significantly more. While
battery life in the headphones themselves
could be a little better, these sensibly priced
headphones remain an excellent choice and an
easy recommendation. HOLLIN JONES


https://us.nothing.tech

THE PLAYBACK IS
STUNNING, RICH AND
EXPANSIVE WITH
POWERFUL LOW END,
CLEAR MIDS AND
SPARKLING HIGHS
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The Go Link has a USB-C
interface, with USB-A
and Lightning adaptors
also included.

THE BOTTOM LINE

Useful connectivity
features and great
sound quality —
simply a bargain for
music lovers.

Great price

USB-C, USB-A and
Lightning

Excellent sound quality

B2 Not the most powerful
DAC available

AWESOME EREEER
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IFi Audio Go Link

A high—quality portable DAC at a competitive price

$59 From[hifps:/ifi-audio.com

Features USB-C interface, with USB-A and Lightning adaptors; Audio support — 32-bit/384kHz, MQA, .

DSD; Dimensions — 5.3" x 0.5" x 0.3", 0.40z

IT'S TAKEN A few years, but more and more
people are now opting to use a DAC — digital-
analog converter — to get the best audio
quality when listening to high-res or spatial
audio. The iFi range of DACs provides high-
quality sound at competitive prices, and its
new Go Link is the most affordable — and
most portable — DAC we’ve seen so far.

Small enough to sit comfortably in the palm
of your hand, the Go Link is solidly built, with
a magnesium alloy casing and braided cable
that are sturdy enough to cope with being
squashed into a pocket or bag when traveling.

There’s a USB-C interface on one end of the
Go Link for connecting to computers and
mobile devices, with a USB—A adaptor included
for older computers. There’s even a Lightning
adaptor for iPhones and iPads too — which, at
this price, is excellent value for money.

The DAC provides a gold-plated 3.5mm
audio socket for wired headphones, and is
driven by a specialized audio chip — an
ES9219MQ for hi—fi buffs — that provides

high-quality sound and also acts as an
amplifier. It supports audio formats up to 32—
bit/384kHz — compared to 16-bit/44.1kHz for
standard CD quality — so it can handle the
highest quality audio provided by Apple Music.
It also supports the high-res MQA format that
is used by rival services like Tidal, and the DSD
format used by some specialist audio services.

Those technical details are pretty impressive
for such an affordable device but, of course,
everything boils down to sound quality. The Go
Link doesn’t disappoint, and copes admirably
with the dense wall of sound on The Big Sky by
Kate Bush, and deftly captures the dramatic
sound of the ocean swirling in the introduction
to Max Richter’s The Waves. Admittedly, the
compact Go Link doesn’t have the sheer power
of some of the more expensive DACs, but it’s
more than powerful enough for listening to
music while you’re traveling, or getting you
motivated for your workout sessions, and at
this price its high—quality sound is an absolute
bargain. CLIFF JOSEPH

Image rights: iFi audio.
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Anker 675

Tough testing, trusted ratings

A versatile, all-in-one monitor stand

$249.99 From[www.anker.com

Features Dimensions — 21.26" x 8.66" x 3.54"; 3x USB-C, 3x USB-A, SD/micro-SD, 1x HDMI, 1x
Gigabit Ethernet, 1x audio in/out, 1x Qi wireless charger Needs macOS 10.14 or later

AS STYLISH AS Apple’s Mac designs are,
they’re often something of an ergonomic
disaster, with monitors that don’t allow you to
adjust the height of the screen and many
models suffering from a shortage of ports and
connectors. Anker’s new 675 dock is a little
pricey, but it aims to solve all those problems
by providing an impressive set of ports and
other features, while also doubling up as a
convenient monitor stand.

The Anker 675 is quite large and has its own
chunky power supply unit as well, so you’ll
need a fair bit of desk space to get it set up.
However, you’ve got room to tuck a few bits
and pieces underneath it, and there’s a holder
on the underside of the dock for wrapping
cables to keep them out of sight.

Underneath the 675 you’ll find the power
connector for the dock itself, and the main
USB-C port that is used to connect your Mac or
PC, and which can also provide up to 100W
power to charge a MacBook or other laptop.
There’s a USB-A port under there too, along

Image rights: Fantasia Trading LLC.

with a Gigabit Ethernet port for wired
networks, and an HDMI port that will
allow you to connect a single external
display, up to 4K resolution at 60Hz
refresh rate.

There’s a second set of ports located
on the left-hand side of the dock, with
two more USB-C and two USB-A ports,
slots for SD and micro—SD memory
cards, and an audio in/out connector.
The top panel of the dock also houses a
Qi charging pad for your iPhone or
earbuds. It’s a little odd that the USB-C
ports can’t be used to connect an
external display — such as Apple’s own
Studio Display, which doesn’t have
HDMI at all. Even so, the Anker 675 will
still be a really useful option for many
people who simply want to connect their
MacBook or desktop Mac to a single
(non-Apple) external display, and also
charge and connect a variety of mobile
devices as well. CLIFF JOSEPH

The stand features a useful
collection of built-in ports
and connectors.

THE BOTTOM LINE

The reliance on HDMI
for video output may
deter some people,
but the Anker 675 will
be a good dock/stand
for general office use.

Lots of ports
and connectors

Provides a stand for
your monitor

Includes Qi charging pad

B Video output via
HDMI only

GREATEEE®
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Photomator 3

In-depth photo editing on your Mac

Free; $4.99/month; $29.99/year; $99.99 lifetime
From|www.pixelmator.com| Needs macOS 13.0 or later

- THE TEAM BEHIND
Pixelmator Photo has
used the update to
version 3 to rebrand

the app as Photomator, adding a
bunch of new features at the
same time. It syncs to your
Photos library and stores edits
nondestructively in the cloud,
meaning you can always undo
changes and your photos will be
accessible to the app both on the
Mac and on iOS. Your purchase
also unlocks the iOS versions and
while the Mac app is free to
download and use, you only get
three saves before you’ll have to
choose a purchase option to
make any more.

It supports RAW files and is
generally pretty snappy in
operation even when working
with large images. You get a
selection of machine learning-
based tools for making quick
edits, from one-click
enhancement to more advanced
features like super resolution to
intelligently increase canvas size,
match colors between images,
denoise and repair. There’s also
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ML-powered selection with
subject, sky and background all
able to be identified and masked
very accurately. Unlike some
similar non-Adobe photo editors,
Photomator uses a basic layer
system to help you manage your
edits. This isn’t for importing
other graphics but for applying
nondestructive edits like
selectively changing color hues,
altering the brightness of the
sky, the clarity of your subject,
and many other possibilities.

POWERFUL IMAGE EDITING
These edits are facilitated by
masks, which appear in your
Layer palette and can be easily
inverted or modified using a
brush, say for example to include
or exclude an area that the
auto-masking didn’t pick up. All
the things you can change using
these tools can also be applied to
the basic image of course,
without using any special tricks.
Most sections have a ML button
you can hit to make auto-
adjustments. So you can make
the whole image sharper,

Many editing tools
are available with a
ML-powered one-
click option.

Subject, sky and
background
detection let you
quickly change
selective parts of
an image.

brighter or darker, or edit the hue
and saturation of its colors. Some
handy presets are available too
that let you punch in a “look”,
and these are subtle rather than
outlandish. You can save your
own presets, batch process
images and even export your
settings as a LUT (look-up table).
The image editing tools are
powerful but easy enough for less
experienced users to master after
a little practice. They’re arguably
on a par with Lightroom, though
Adobe’s app is stronger when it
comes to library management.
Among the other features you
will find cloning and a Repair tool
that can remove objects from
images. As is often the case, this
is great with smaller items but
can struggle a bit with larger
ones. There are also some
ML-powered workflows which
are useful for batch processing. It
can also intelligently crop images
to make them more striking,
though this is something that
more experienced photographers
would always do manually.

AN ADOBE ALTERNATIVE
Images are saved to your Photos
library but remain editable from
Photomator. You can also export
images in a number of formats
with variable quality settings,
though curiously not Photoshop
format. If you export a
Photomator document it can be
opened in Pixelmator Pro and

Image rights: Apple, Hollin Jones, Pixelmator Team.
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retains its editable layers, which
is useful if you want to add more
graphical elements or text.
Photomator is a very adept tool
for editing your pictures and the
developers are working on
support for features including
file browser support, dehaze and
video editing among other
things. It all feels slick and
friendly and moving effortlessly
between Mac and iOS is a nice
touch too. Not everyone likes the
subscription model even though
it’s widely used nowadays and
looks set to stay — you might

Image rights: Apple, Hollin Jones, Pixelmator Team.
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find that S30 for a year is the
sweet spot to see how this
powerful editor fits into your
photo life. HOLLIN JONES

THE BOTTOM LINE

A powerful and well-featured

image editor that's easy to use and

produces great results.
Good depth of editing tools
Layers are very useful

ML features work well

B Catalog features limited
EXCELLENT HmmmS
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Workflows are
actions you can
quickly apply to
batches of images
for quick editing.
As well as

selective editing,
preset looks are
available for
quick application
to photos.

Tough testing, trusted ratings

“THE IMAGE EDITING
TOOLS ARE POWERFUL
BUT EASY ENOUGH FOR

LESS EXPERIENCED

USERS TO MASTER"

Match
colors
between
images

If you select Tools >
Match Colors you can
select an image to
analyze and from which
to transfer the color
balance to your current
photo. This is much
quicker than doing it
manually when you want
two images to have the
same feel.

Use
workflows

Select one or more
images in your library,
right-click and choose

Workflows and then
More Workflows. Here
you can access many

automated tasks for
batch processing
images in multiple ways.

Change
layer
intensity

If you have used layers
to nondestructively
make changes to an

image or parts
of an image, you can use
the Intensity slider for
each layer to set a more
moderate value
than simply O or 100.

AUG 2023



The mic has eight RGB
lighting modes, but you
can turn off the lights

if you prefer.

THE BOTTOM LINE

The RGB lighting may
catch the eye, but this
mic's audio quality is
what you'll love most.
Fantastic audio quality
Built-in shock mount

D Robust construction

2 USB-A cable
EXCELLENT EEmmE

74 | AUG 2023

Cherry UM 9.0 Pro RGB

Come for the RGB, stay for the audio

$139.99 From[www.cherry-world.com

Features Four polar patterns (cardioid, omnidirectional, bidirectional and stereo), included shock mount
and tripod stand, RGB lighting, gain control, mute button, 3.5mm headphone jack with volume control,

braided USB-C to USB-A cable

THERE AREN'T MANY RGB-infused USB
microphones out there, but Cherry’s new UM
9.0 Pro RGB microphone brings the light show
to your desk. The Cherry’s mouthful of a mic
feels absolutely solid, with the easily
adjustable stand being cast from sturdy metal.
That said, Cherry’s device trades portability for
durability, and it’s a pretty sizeable
microphone that won’t pack up small for
travel. If you need a compact mic for the road,
you might want to look elsewhere.

There’s a built-in shock mount to help
reduce unwanted noise and vibrations, which
could make all the difference in your
recordings. There’s no pop filter, but plosives
were a total non-issue in our tests. Speaking of
recordings, Cherry’s effort fares magnificently
here. Our test recordings came out perfectly
clear, with no hint of the muffled and tinny
output that can often befall desktop mics. The
quality was so good, it was like listening to
someone sitting in the room next to us.

We had to turn up the gain to get the best
results, but it didn’t need to be maxed out.
Even with the gain dialed all the way up to full,
clarity was kept intact and there was no
clipping anywhere within earshot.

There are four polar patterns to choose
from: cardioid, omnidirectional, bidirectional,
and stereo. Changing the mode requires
pushing in the gain dial, which cycles through
each setting; the pattern of lights on top of the
device indicates which mode is selected. We
would prefer a more obvious way to pick a
polar pattern, such as a dedicated button with
clearly labeled options. It’s a relatively small
complaint, like the fact that the mic only
comes with a USB-A to USB-C cable and no
USB-C adapter for modern Macs.

It is also on the pricey side for a USB
microphone, but you absolutely get what you
pay for. The superb audio output, included
shock mount and rock-solid build quality
make that money well spent. ALEX BLAKE
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Roadwarden

Tough testing, trusted ratings

Secure a harsh land in this superb RPG

$10.99 From :
Needs 0S X 10.10 or later

ROADWARDENIS THE kind of
pure role-playing game (RPG)
experience you don’t see so
much these days. There are no
fancy 3D graphics and convoluted systems,
but instead a heavy focus on storytelling
and decision—making. It may look simple
on the surface, but this text-based
adventure is deep and complex, with huge
replay value and branching storylines. As a
roadwarden, you travel the lonely trails of a
wild and inhospitable peninsula as a
representative of a far-off land, attempting
to ward off dangers, broker agreements,
and generally keep the peace among
disparate and distrustful people.
The game is deeply steeped in its own
lore, history and culture, and playing
for the first time feels like dropping
into a living world that carries on with or
without your input. The map is large and
your time is limited, with 40 days to
explore the peninsula before the clock runs
out. You can’t do everything, but that
just encourages you to play again.

NO OBVIOUS ANSWERS

Every decision you make can impact the
story. You can address the varied characters
in multiple ways, with different responses
and inflections, from friendly and joking to
intimidating. Sometimes, lying is your best

Each corner of the map is filled with interesting
characters, all struggling to survive in a cruel realm.

Image rights: Assemble Entertainment GmbH, Moral Anxiety Studio.

bet. Each choice you face feels weighty —
there are no easy ways out. Certain
situations come down to a dice roll, like
deciding whether you survive a fight
unscathed or take heavy losses, which
imbues combat with a real sense of peril.
Every interaction is interesting, and every
encounter a chance to advance the story in
unexpected ways.

Roadwarden is heavy on text. While its
world is full of characters, the graphics are
mostly reserved for environments and
settlements. That’s fine, though, because

the game’s pixel visual style is captivating.

Its music, too, is enchanting, and at times
leaves you feeling like you’re sat in a
medieval tavern as a fire crackles and your
mug is filled with mead.

If you’re not a fan of text—based games,
Roadwarden might not have much appeal.
But RPG enthusiasts will find much to love
here. It’s one of the most polished
traditional RPG experiences on macOS.
ALEX BLAKE

Adopting the right tone
can help your chances —
or dash them.

THE BOTTOM LINE

With its complex lore
and impressive
writing, Roadwarden
is a welcome gift for
RPG lovers.

Excellent writing & story

Your decisions matter

Attractive graphical style

2 Drains your battery
surprisingly fast

EXCELLENT HEEN0
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@ Reviews

Best of the best

Can't find the hardware or app you're looking for in our reviews section? Then check in

here — we've highlighted the best in every major category, as voted for by us

>HARDWARE

CATEGORY

MESH ROUTER

4K USB-C MONITOR
THUNDERBOLT DOCK
KEYBOARD

PORTABLE PRINTER
PORTABLE HDD

NAS DEVICE

WIRELESS CHARGER
DESKTOP SPEAKERS

E ‘IN-EARHEADPHUNES
SECURITY CAMERA
SMART SPEAKER
OVER-EAR HEADPHONES
AIRPLAY SOUNDBAR
WEBCAM

PHOTO PRINTER
PORTABLE BATTERY PACK
MOBILE DOCK

OFFICE CHAIR

MOUSE

ACTION CAMERA

E ‘ DESKTOP MICROPHONE
PORTABLE DAC
PORTABLE SSD
THUNDERBOLT 4 HUB
CD/DVD DRIVE

TRAVEL CHARGER
iPHONE GAME CONTROLLER
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PRODUCT

ASUS ZenWiFi XT9

Ben( EW3280U

CalDigit Thunderbolt Station 4
Cherry KW 9100 Slim for Mac
Epson WorkForce WF-TI0W
Toshiba Canvio Flex 2TB
Asustor Lockerstor 2 Gen 2 AS6702T
Belkin BoostCharge Pro Portable
Creative Pebble Pro

Nothing Ear 2

EufyCam 2C (two-pack kit)
HomePod mini

Sony WH-1000XM5

Sonos Beam

AnkerWork B600 Video Bar
Liene 4x6 photo printer

Anker 533

Kensington 8-in-1 USB-C Mobile Hub
Branch Verve

Logitech MX Master 3S

GoPro Hero 11 Black

Cherry UM 9.0 Pro RGB

iFi Go Blu

Crucial X8

Satechi Thunderbolt 4 Slim Hub
NOLYTH External DVD Drive
Mophie 3-in-1travel charger

Razer Kishi v2

aldigit.co
PpSoN.co
ptorage.toshiba.co
hsustor.co
pelkin.co

s.creative.co

BON0S.Co

ensington.co
pranchfurniture.co
ogitech.co
jopro.co

cherry-world.co
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rucial.co

batechi.ne

razer.co

$449.99
$799.99
$379.99
$59.99
$299.99
$79.99
$459
$59.99
$59.99
$149
$239.99
$99
$399.99
$4h9
$219.99
$136.99
$49.99
$71.55
$549
$99.99
$500
$139.99
$199
$219.99
$199.99
$39.99
$149.95

$99.99

#201

#169

#199

#208

#185

#197

#205

#197

#204

#209

#17

#176

#197

#187

#191

#190

#198

#190

#201

#198

#202

#209

#189

#203

#205

#204

#202

#203
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>i0S/iPadOS APPS

T0 DO (PRODUCTIVITY)
WRITING

EMAIL

PHOTO EDITOR

VIDEO EDITOR
CAMERA

RSS READER
DESKTOP PUBLISHING
NOTE-TAKING
MIND-MAPPING
DOCUMENT SCANNER
CALENDAR

FITNESS

SHOPPING

GRAPHICS

> macO0S APPS

PRODUCT

Things 3

& Scrivener

Spark

@ Pixelmator Photo 2
8 LumaFusion 3.0

. Obscura 3

PN Reeder 5

Affinity Publisher 2

€3 Notability 10

¥ MindNode 7

~= Genius Scan 6.0

£ Fantastical 3

W Gentler Streak
Grocery 3

Procreate for iPad

ulturedcode.co
iteratureandlatte.co

parkmailapp.co

uma-touch.co!

eeder.app
affinity.serif.co
pingerlabs.co

indnode.co

hegrizzlylabs.co
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exibits.co

martgrocery.app

procreate.ar

$9.99 #194
$19.99 #138
Free #190
$4.99 #193

$29.99 (1APs) #186

$9.99 #196
$4.99 #176
$19.99 #206
$8.99 #174
$14.99 #184

Free (IAPs) #182
$4.99/month  #198
Free (IAPs) #199
Free #198

$9.99 #196

T0 DO (PRODUCTIVITY)
WRITING

EMAIL

IMAGE EDITOR

VIDEO EDITOR

SCREEN CAPTURE

MUSIC CREATION
PASSWORD MANAGER
DESKTOP PUBLISHING
BACKUP

VIRTUALIZATION
TIME-TRACKING
NOTE-TAKING

AUDIO AND VIDEO CONVERTER
VIRTUAL PRIVATE NETWORK

PRODUCT

Things 3

& Scrivener

Spark

& Pixelmator Pro 3
a Wondershare Filmora
% ScreenFlow 9

B Logic Pro

(s) Secrets

B Adobe InDesign
[# Carbon Copy Cloner
E] Paraliels Desktop 18
@ Tyme3

/A Agenda

@ Wondershare UniConverter

@) NordveN

ulturedcode.co

iteratureandlatte.co

ksparkmailapp.co

pixelmator.co!

wondershare.co

elestream.n

pdobe.co

hombich.co

ondershare.co

ordvpn.co
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$49.99 #194
$49 #200
Free #190
$49.99 #208
$109.99 #202
$129.00 #164
$199.99 #141

$19.99 #188

$20.99/month  #162
$39.99 #136
From $99.99 #201
$3.99/month  #169
Free #204
$49.99/year #203

$11.95/month #186
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